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For Windows

How to use the application on Windows



Introduction

Purpose of this manual

This manual explains how to use the XDCAM EX Clip
Browsing Software on Microsoft Windows. This manual
is intended for users who will use this application to
perform file and folder operations. It assumes that readers
have a basic familiarity with Microsoft Windows.

Notes on use of XDCAM devices

* This software cannot access an XDCAM HD device
while another XDCAM-compatible application
(XDCAM Transfer/PDZ-1) is accessing that device.

* While running this software, if it becomes necessary to
connect/disconnect the i.LINK cable or power on/off the
XDCAM device, always do such operations after you
exit this software.

Overview

The XDCAM EX Clip Browsing Software allows you to
work with clips created with XDCAM EX/XDCAM HD
devices.

After installing this application on your computer, you can
use its intuitive graphical user interface to organize your
clips by copying, moving, and deleting them. You can also
perform format conversions, preview the clips, and view
their metadata.

This application supports XDCAM EX/XDCAM HD

compatible data. D

1) For XDCAM HD compatible data, executable operations are limited (see
next section).

New functions supported in Version
2.5

The following table shows the principal new functions
supported in Version 2.5.

Function Description Reference
XDCAM HD file You can operate on -
operations XDCAM HD files (MXF

files).

However, the

operations are limited

to copying, deleting,

and previewing.
Converting EX files | You can convert Page 19
to MXEF files by XDCAM EX files (MP4
copying files) to MXF files by

copying them to a folder

with MXF attributes.
Extended export You can convert files to | Page 24
function XDCAM MPEG IMX

and XDCAM DVCAM

format files.

Hardware and software
requirements

Install this application on a computer meeting the
following hardware and software requirements.

ltem Description

0S Microsoft Windows XP SP3 or higher (32-bit
version), or Microsoft Windows Vista SP1 or
higher (32-bit version) @

CPU Intel Pentium 4 2.0 GHz or higher (Intel Core 2
Duo Processor 2.0 GHz or higher
recommended) ©)

Memory 1 GB or more (2 GB or more recommended)

Display Resolution: 1280 x 1024 pixels or better

Introduction / Overview
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ltem Description
Audio Audio playback function
Other Windows Desktop Search (WDS) ©)

a) Microsoft, Windows, and Windows Vista are registered trademarks of
Microsoft Corporation in the United States and other countries.

b) Intel, Intel Core and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other
countries.

¢) To use keyword searching on Windows XP, the latest version (Version
3.00 or higher) of Windows Desktop Search (WDS) must be installed.
Keyword searching is not available if WDS is not installed or if the
installed version is not the latest version.

The WDS component is preinstalled on Windows Vista. It does not need
to be installed again.

All product names and brand names are registered
trademarks or trademarks of their respective owners.

XDCAM devices supported by the
application

This application supports the following XDCAM devices:

Series hame Model name

XDCAM HD422 (Version 1.2 or higher) PDW-700

PDW-740

PDW-HD1500

XDCAM HD (Version 1.92 or higher) PDW-F355L

PDW-F335L

PDW-F335K

PDW-F75

XDCAM HD Drive PDW-U1

Installing the Application

Installing the Application

If the MainConcept plug-in software is installed
Update the plug-in software to the latest version (see page
44).

You can use the extended export function of the XDCAM
EX Clip Browsing Software Version 2.5.

If Version 1.0x is installed

Uninstall Version 1.0x (1.00 or 1.01) (see page 9) before
you start the installer.

Installing from the CD-ROM
1 Insertthe supplied CD-ROM into the CD-ROM drive
of your computer.

The cover page appears automatically in your browser.
If it does not appear, double click index.htm on the
CD-ROM.

2 Select and click [Windows XP/Vista] from the
XDCAM EX Clip Browsing Software Installer.

The folder where the setup application is stored
appears.

3 Double click Setup.exe.

The setup wizard appears.

15! KDCAM EX Clip Browser - InstaliShield Wizard

Welcome to the InstallShield Wizard for
XDCAM EX Clip Browser

The InstallShield (R} Wizard will install XDEAM EX Clip Browser
on your computer. To continue, dick Mext.

WARMING; This program is protected by copyright law and
international treaties.

4 Click the [Next] button in the setup wizard.

A license agreement screen appears.

5 Click the [Accept] button, and then click the [Next]
button.

The following screen appears.



15! XDCAM BX Clip Browser - InstallShield Wizard

£l

Setting of Install Options

Please select desired install options.

Language selection

Specified langua... |English &

Country
@ NTSC [TIPAL

Install destination folder

i e
0 ! C:\Program Files\Sony\XDCAM EX ClipBrowser | | Change....

Mext> | | Cancel ‘

6 Change the settings as required, and then click the
[Next] button.

To change the installation destination
Click the [Browse...] button and select the folder in the
dialog that appears.

Complete the installation by following the instructions
on the screen.

The following screen appears when the installation
finishes.

15! XDCAM EX Clip Browser - InstaliShield Wizard

Installshield Wizard Completed

The Installshield Wizard has successfully installed XDCAM EX
Clip Browser. Click Finish to exit the wizard.

Finsh |

7 Click the [Finish] button to close the dialog.

To uninstall the application

Select Add or Remove Programs in the Windows Control
Panel, and then select and delete [XDCAM EX Clip
Browser] from the list of installed programs.

Uninstalling the application also uninstalls the
MainConcept plug-in software at the same time.

Launching and Exiting
the Application

See “Installing the Application” (page 8) for more
information about how to install the application.

Launching the application

Double click the shortcut icon on the desktop.
The XDCAM EX banner appears, the application starts,
and the operating windows (see page 10) appear.

It is not possible to launch more than one instance of this
application at one time.

Exiting the application

Do one of the following.

¢ Select [Exit] from the [File] menu.

* Click the x button in the upper right of the operating
window.

Do not power off the computer while a file operation is still
underway. Files may be corrupted. Wait until the operation
finishes, or cancel the operation, before powering off.

Launching and Exiting the Application
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Operating window configuration

The following figure shows the default configuration of
the operating windows.

T
S
=
=
o
Qo
2
17

© Main window

rowser - Explorer

|~ | Explorer

=

20 qmm

0]

Used space
Free space

General | AV Format | Related Info
(= 5 Markin Mark Gt

Last Updata
Duration

Status
Title 1
Title 2
Creator

Description

@ Explorer windows ) Preview window

© Main window
This is the main window of 'the application. It contains Name of this application
Explorer windows and Preview windows.

The title bar displays the name of this application,
followed by the title of the active window inside the main
window frame (Explorer or Preview).

The menu and menu items in the menu bar change
depending on the window inside the main window frame
(or the active window, when more than one window is
open).

Title of the active window

Menu bar

© Explorer windows

You can have up to ten Explorer windows open at one
time. When you have more than one window open, you can
convert them into tabs on one window.

1 0 Names and Functions of Parts



For details, see “Explorer window” (page 12).

©® Preview windows

You can have up to five Preview windows open at one
time. When you have more than one window open, you can
convert them into tabs on one window.

For details, see “Preview window” (page 15).

To customize the window configuration

To open another window

Select [New Explorer Window] or [New Preview
Window] from the [Window] menu. A new Explorer or
Preview window opens.

To tab windows

You can convert windows of the same type (Explorer or
Preview) into tabs in a single window.

To tab a window, drag it and drop it on another window.

Tabbed windows

When one Preview window is already open, you can open

a new Preview tab by doing one of the following in an

Explorer window.

* Double click a media file in the List View pane.

* Select a media file in the List View pane, and then select
[Play] from the [Clip] menu.

If the selected media file is already loaded into its own
Preview window or a Preview tab, that window or tab is
activated.

To convert a tabbed window back into a separate
window

Drag the tab of the window that you want to separate away
from the other window.

Other window operations

* Drag the window title bar to move a window.

* Resize a window by dragging on any window border.

* Click a maximize button in the upper right corner of a
window to maximize it.

* Close a window you do not need by clicking the x (close)
button in the upper right corner.

The application remembers your most recent configuration
and recreates it the next time it starts.

To optimize the window configuration

Select [Optimize Window Layout] from the [Window]
menu. This optimizes the positions of Explorer and
Preview windows in the main window.

Keyboard shortcuts for selecting windows
and tabs

You can use keyboard shortcuts to select windows and
tabs.

To select the next window from the keyboard
Hold down the Ctrl key and press the Tab key. (This
manual refers to this operation as “press Ctrl + Tab”.)
The next window is selected with each key press.
You can select the next window in reverse order by
pressing Ctrl + Shift + Tab.

Names and Functions of Parts
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To select the previous or next tab from the

keyboard Tool buttons Function Reference
Press Ctrl + PageUp, or Ctrl + PageDown. Icon Name
New Folder |Creates a new Page 29
folder in the
: currently selected
Explorer window media or folder.
Explorer windows are where you operate on clips (files) ﬁ Find Opens the Find Page 27
and folders, and where you check clip metadata. You can A, dialog.
operate on XDCAM EX/XDCAM HD format folders and
media. Up Moves up to the -
next higher folder.
Tab Split Folder | Opens the Split Page 30
D Path . Folder dialog.
) Toolbar
_ - Copy All Copies all of the Page 20
[~ Extor clips in the selected
media or folder to a
new folder. This
application creates
the new folder
automatically.
Cut Cut the selected Page 20
; Copy Copy the selected | Page 18
! clip.
p
Paste Pastes a clip that Page 18
o has been cut or Page 20
List View pane copied. This can be
Information about selected clips used to move a clip
5 Folder t to another media or
oldertype folder.
© Capacity
) = Delete Delete the selected | Page 21
O Tree View pane |ﬁ1' clip or folder. Page 30
p- Folder Tree |Shows or hides the |—
O Tab '_I:,-_ Display/ Tree View pane.
The tab displays the name of the media or folder that is N | Hide
selected in the Tree View p ane. Thumbnails |Puts the List View |-
When two or more Explorer windows are open, you can rﬁ pane into
drag and drop the tab on another window to convert this = thumbnails view
window into a tab on the other window (see page 11). mode.
Clip List Puts the List View |-
© Path — pane into list view
This is the full path to the media or folder that is selected - mode.
in the Tree View pane. Details Puts the List View |-
E pane into details
©® Toolbar T view mode.

Contains tool buttons for operations on clips and folders.

Names and Functions of Parts

O Tree View pane

Displays a tree of media and folders located beneath My
Computer.

The following icons represent the type of the media or
folder.




Icon Type of media or folder

Hard disk drive

CD, DVD or Blu-ray Disc drive

XDCAM drive (normal)

XDCAM drive (UserData)

SxS memory card drive

Mass storage device (removable drive)
connected by USB

Mounted network drive

Normal folder, not managed by this application

1@ U@ 8 e

Folder with EX attributes

}

Folder with MXF attributes

The Tree View pane supports the same kinds of operations
as the tree panel of Windows Explorer.

You can show or hide folder contents by clicking the
Folder Tree Display/Hide button on the toolbar.

* When you select a media item, a message may appear
saying that salvage is required, and that you should
salvage the media on the device that recorded it. This
message appears when the data is defective, typically
because the XDCAM EX device was powered off or the
media was ejected too soon during recording. If this
message appears, you should reinsert the media into the
XDCAM EX device and attempt to salvage it as soon as
possible. The data may become unrecoverable if you
continue to work with it without salvaging it.

* Depending on the Windows desktop theme, some
characters may fail to appear in list view. But this has no
effect on operations by this application.

Media

In this manual, “media” refers to the following media
types.
* SxS memory cards

* USB memory

* Internal hard disks

» Externally connected hard disks

* CD-R discs

* DVD-R discs

* Blu-ray discs

¢ Professional Discs (XDCAM drives)

© Capacity

Displays the used capacity and remaining capacity of the
media selected in the Tree View pane.

The remaining capacity is shown as a numeric value and as
a bar graph. The orange bar grows longer as more of the
media’s capacity is used.

@ Folder type

Displays the type of the folder being selected in the Tree
View pane.

EX: Folder with EX attributes

MXF: Folder with MXF attributes

@ Information about selected clips

Displays information about the clips that are selected in the
List View pane (number of selected clips, total clip length,
and total size).

The total clip length is an approximate value, so take it as
an approximate guide.

© List View pane

Displays the clips in the media or folder that is selected in

the Tree View pane. You can select from the following

three view modes.

Thumbnail View: This view displays the index picture of
each clip (or a thumbnail of the first frame, when no
index picture is set). It also displays the name of the
clip and the date and time when the clip was shot.

List View: This view displays an icon indicating the type
and current state of the clip, and the name of the clip.

Details View: This view displays an icon indicating the
type and current state of the clip, the name of the clip,
and its properties.

To switch the clip view mode

Do one of the following.

¢ Select [Thumbnails], [List], or [Details] from the [View]
menu.

¢ Click the Thumbnails, List, or Details button in the
toolbar.

A mark for the clip status is displayed on the thumbnail or

icon in all of the view modes.

Names and Functions of Parts
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View mode |Icon Description
List or Normal MP4 file
Details view

View mode | Thumbnail display
example

Description

MP4 file with OK status (as set on
the XDCAM EX device) @

gl @

An MP4 file in which some of the
video cannot be displayed.
However, other parts of the video
can be previewed, and the
properties of the MP4 file can be
edited like the properties of
normal MP4 files.

Abnormal MP4 file (without data,
cannot be decoded, etc.)

Normal MXF file

MXEF file with OK status (as set on
the XDCAM device) @

NENE T

An MXEF file in which some of the
video cannot be displayed.
However, other parts of the video
can be previewed, and the
properties of the MXF file can be
edited like the properties of
normal MXF files.

Abnormal MXF file (without data,
cannot be decoded, etc.)

Names and Functions of Parts

Thumbnails Normal clip

view

Clip with OK status
(as set on the

XDCAM EX device) )

Part of a clip that
spans several media
discs or memory

devices. P

A clip in which some
of the video cannot be
displayed. However,
other parts of the
video can be
previewed, and the
properties of the clip
can be edited like the
properties of normal
clips.

A clip that cannot be
loaded. The clip
cannot be previewed,
and its properties

cannot be edited. ¢ 9

a) Clips with OK status can be moved or deleted by this application.

b) XDCAM EX devices automatically save video that exceeds 4 GB in size
as multiple clips. These clips are parts of the complete recording and can
be saved on multiple media. Not all of the original recorded video is played
back when a split clip is played back.

¢) A clip that cannot be played or displayed properly by this application. The
file may be corrupt, file links may be broken or changed, required files
may be missing, or thumbnail creation may have failed.

d) A clip that cannot be played or displayed properly by this application.
Another application is using the clip file.

To sort the Details View list

Click the header of the column that you want to use as the
sort key.

Each click sorts the list again in ascending or descending
order.

You can also sort by selecting one of the following items
under [Sort By] in the [View] menu.

¢ Clip Name

* Size

* Duration

* Status

* Creation Date

e Last Update

¢ Recording Mode

¢ Media Spanning




To select the items to display in Details View
Open the dialog shown below by selecting [Customize
Columns...] from the [View] menu, and then proceed as
follows.

[ Customize Columns

Please select items 1o be displayed.

Down

Show All

L] ption
Elyideo Port
Rividea ¢
B aptur

Hide All

"Reset to Default

To select an item to display: Check the check box. You
can click the [Show All] button to check all of the
check boxes.

To select an item to hide: Clear the check box. You can
click the [Hide All] button to clear all of the check
boxes except “Clip Name”.

To change the display order: Click an item to highlight
it, and click the [Up] or [Down] button.

To return to the default settings: Click the [Reset to
Default] button.

To confirm the changes: Click the [OK] button.

To cancel the changes: Click the [Cancel] button.

Preview window

Preview windows are where you preview clips and check
clip information.

Notes about the Preview window

Playback in this window is preview playback. Note the

following points.

* Depending on the performance of your computer and the
processing load, dropped frames may occur, timecode
may differ from the actual values, the clip may not be
played smoothly, and some time may be required before
the screen is updated.

* When the playback clip is defective, video breakup may
occur and the playback may freeze.

* Not all of the original recorded video is played back
when a split clip is played back.

* It may not be possible to play clips created on devices
other than XDCAM EX devices.

* Improper playback may occur if the screen properties of
your computer are changed during playback. If this
occurs, restart the application.

Tab

B Clip name
B Viewer

| I~ | Preview - |j09_0019_01

General | AN Format | Related info

s Markin Mark Out

- -

Status
Title 1 709_0019_01
Title 2

Creator

[

B Clip properties section
@ Splitter

O Tab

Displays the clip name.

When two or more Preview windows are open, you can
drag and drop the tab on another window to convert this
window into a tab on the other window (see page 11).

9 Clip name
Displays the clip name of the selected tab.

©® Viewer
Previews clips (see next section).

(4) Splitter
You can drag the splitter up and down to change the
relative sizes of the viewer and the clip properties section.

@ Clip properties section
Allows you to check clip properties (see page 17).

Names and Functions of Parts
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Viewer

© Screen

@ Clip type

© Number of essence marks
O Timecode

Command buttons

Playline
Position bar

© Screen

Displays the playback video.

You can double click the screen or select [Full Screen]
from the [View] menu to enlarge the size to full screen
size.

To return to the original size, double click the screen again
or press the Esc key.

© Clip type

Displays the type of the clip being viewed on the viewer.

XDCAM EX: XDCAM EX clip (MP4 file)

XDCAM HD/HD422: MPEG HD file created from
XDCAM HD or XDCAM HD422 clip (MXF file)

XDCAM HD Proxy: Proxy file created from XDCAM
HD or XDCAM HDA422 clip (MXF file)

© Number of essence marks

Displays the number of the essence marks set in the clip (in
the format of: actually set number/maximum allowable
number).

O Timecode

Displays the timecode of the current position (playline
position), and the duration of the section between In and
Out points in the clip. A counter value is displayed when
no timecode is recorded in the clip.

For NTSC clips, a period (.) between the minutes and
seconds of the current position indicates drop-frame, and a
colon (:) indicates non-drop-frame.

It is possible to jump to a specified position by clicking the
current position timecode, entering a numeric value, and

Names and Functions of Parts

pressing the Enter key. (This operation is ignored when
invalid timecode is entered.)

You can change the timecode display format. For details,
see “User settings” (page 34).

© Position bar

Displays the time scale of the clip.

The following marks are shown on the position bar to
provide information about the clip.

Mark Meaning
. In point
. Out point
“ Essence mark
Timecode break point (discontinuous
E timecode)
0O Playline

Displays the current position on the time scale.

You can drag the playline or click anywhere on the
position bar to move to a desired position. Scrubbing
(repeatedly dragging to the left and right) is also supported.

©@ Command buttons

These buttons perform various clip preview operations.
The functions of these buttons can also be accessed from
the keyboard.

Icon Button Keyboard | Function

name operation

Jump to Home Jumps to the clip

Start start point (first
frame).

Jump to End Jumps to the clip

End end point (last
frame).

Mark In® | Sets an In point at

the current

position. Can be
done during play
(play continues).

Play Into | Shift +
Out Space

Plays the section
from the In point
to the Out point.
(During play, the
button icon lights
green.) Stops play
if clicked during
play.

f oom




Icon Button Keyboard | Function Icon Button Keyboard | Function
name operation name operation
Mark Out @ | O Sets an Out point Capture - Saves the frame
at the current E Still Image at the current —
position. Can be position as a —

done during play
(play continues).

Clear Mark
In/Out &

Shift + X

Clears In and Out
point settings.
Can be done

during play (play
continues).

Jump to In
point

Jumps to the In
point.

bitmap file. This
command opens
a dialog where
you can specify
the file name and
save destination.
However, still
images cannot be
created from a
clip on XDCAM
disk.
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Jump to
Out point

Jumps to the Out
point.

Play

Space

Plays the clip.
(During play, the
button icon lights
green.) Stops play
if clicked during
play.

Add
Essence

Mark @

Adds an essence
mark at the

current position.
Can be done
during play (play
continues).
However, an
essence mark
cannot be setat a
position where
one already
exists.

b)

gy

Delete
Essence

Mark @

Shift + E

Deletes the
essence mark at
the current
position. Can be
done during play
(play continues).

1

Set Index
Picture

Sets the current
frame as the
index picture of
the clip. Can be
done during play
(play stops).

Set Audio
Channels

Opens the Set
Audio Channels
dialog.

a) You cannot use these buttons to apply editing operations on clips existing
on the XDCAM drive. These buttons cannot add or delete edit points (In/
Out points) or essence marks in those clips.

b) The maximum number of essence marks that you can set in a single clip is
as follows, depending on the clip format.

XDCAM EX clip: 126

XDCAM HD clip (less than 126 seconds): the number of seconds + 1 (for
example, 46 marks for a 45-second clip)

XDCAM HD clip (126 seconds or more): 126

Clip properties section

General tab
General | AN Format | Related Info

Mark Out
Clip Name

Creation Date
Last Update
Duration

Title 1
Title 2
Creator

Joo.oate ot

Description

This tab displays general information about the clip.

* Index Picture: Displays the index picture of the clip, or a
thumbnail of the first frame if no index picture has been
set.

* Mark In: Displays a thumbnail of the In point, or a
thumbnail of the first frame if no In point has been set.

* Mark Out: Displays a thumbnail of the Out point, or a
thumbnail of the last frame if no Out point has been set.

* Clip Name

¢ Creation Date (date and time of creation)

 Last Update (date and time of most recent update)

* Duration (clip length)

* Status: Displays the clip status. You can select the status
from among OK, NG, KEEP, and None.

« Title 1: Allows you to assign a title up to 63 ASCII bytes
in length.

* Title 2: Allows you to assign a subtitle up to 127 bytes in
length.

17

Names and Functions of Parts



SMOPUIAN 404

18

* Creator: Allows you to enter the name of the person who

shot the clip, up to 127 bytes in length.
* Description: Allows you to enter a description of the
scene depicted in the clip, up to 2047 bytes in length.

To save changes to the Status, Title 1, Title 2, Creator, and
Description fields, you must click the Update button. The

changes are discarded if you close the window or tab
without clicking the Update button.

A/N Format tab

General | AN Format | Related Info

Video Format

Port DIRECT
MPEG2 HDL
fps Capture

Codec

59.94 Format 53.94i

Layout 144051 q
Frame Phase oo

Pull-Down Type Type 1-1
Audio Format

Number of Channels 2
Channel
Channel

Recording Ports

This tab displays information about the recording format
of the clip.

* Video Format

* Audio Format

Related Info tab

General | AN Format | Related Info

Model Manufacturer
Model Name
Serial Number
Lens Model

Rec Mode

Media Spanning
UMD

Key Frame

User Bit

Proxy AV Data
Edit List

Hard- & Software

This tab displays information related to clip recording
conditions.

* Model

* Lens Model

* Recording Mode
* Media Spanning
* UMID

» Key Frame

* User Bit

* Proxy AV Data

* Edit List

* Hard- & Software

Clip Operations
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Clip operation precautions

Always observe the following precautions during

processing of clip operations.

- Do not power off the computer or media drive before
the operation completes.

- Do not use Windows Explorer or another file
management tool to delete folders that contain the
clips being processed.

- Do not eject the media before the operation completes.

It may be possible to copy and move clips to media with

this application even when the display on an XDCAM

EX device indicates that the media is full. However, it

will not be possible to play back or delete those clips

when the media is inserted into the XDCAM EX device
again (a message will appear saying that the media must
be salvaged).

For the folders created on a hard disk or other media by

copying from XDCAM drive with Windows Explorer or

other folder management tool, editing operations such as
adding and deleting of clips cannot be performed.

When writing clips to XDCAM drive, it is necessary

beforehand to set the NAMING FORM option in the

XDCAM HD device menu to “free (no format).” If the

option is set to “C***%* (standard format),” any clip with

an arbitrary name other than C**** cannot be written to

XDCAM drive.

Writing a 50p or 60p frame rate clip to XDCAM drive

moves the essence marks and Out points at the odd

frames to the previous or next even frames. For example,
the essence mark at the 15th frame moves to the 14th,
while the Out point at the 19th frame moves to the 20th.

However, the Out point will be deleted if an essence

mark already set at the move destination frame.

For details about the menu operations of the XDCAM HD
device, refer to the Operating Instructions or Operation
Manual supplied with the XDCAM HD device.

Copying clips

You can duplicate clips on your media or computer, and
copy clips between media and the computer.

When copying MXF clips to XDCAM drive or a folder
with MXF attributes, it is not possible to copy the clip of a
different recording format from that of the clips in the
destination.



Grouping split clips by gathering them into one
place

XDCAM EX devices automatically save video that
exceeds 4 GB in size as multiple clips. If you collect these
clips into one media or folder, they are automatically
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate
media” (page 21) for more information.

To copy selected clips

1 Selecta clip to copy in the List View pane of an
Explorer window.

* Abnormal clips can be selected, but they are not
copied.

* The folder that contains the selected clips cannot be
specified as the copy destination.

If you want to copy the clips to a new folder
Create a new folder in the copy destination media or
folder.

See “Creating folders” (page 29) for more
information about how to create folders.

2 Do one of the following.

* Drag the clips selected in step 1 and drop them in the
List View pane of another window, or on a copy
destination media or folder in the Tree View pane of
the same window or another window.

* Click the Copy button. Then click the List View
pane of another window, or a copy destination media
or folder in the Tree View pane of the same window
or another window, and click the Paste button of that
window.

* Select [Copy] from the [Edit] menu. Then click the
List View pane of another window, or a copy
destination media or folder in the Tree View pane of
the same window or another window, and select
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the
copy.

| XDCAM EX Clip Browser

3 Click the [Yes] button to execute the copy, or the [No]
button to cancel it.

A dialog illustrating the progress of the copying opens
when the copying starts.

Once it has been completed, you cannot undo the copy
operation.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail

Copy operations may fail for the following reasons. In

these cases, an error message appears and the copy is

not executed.

* There is not enough free capacity at the copy
destination.

* A clip with the same name as one of the selected
clips already exists at the copy destination. Even if
the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* You do not have delete/write privileges to the
destination media or folders.

 The destination media or folder is write protected.

If you copy an XDCAM EX file to a copy
destination with MXF attributes

Copying an XDCAM EX file (MP4 file) to XDCAM drive
or an MXF folder automatically converts the file to the
XDCAM HD format (MXEF file). This makes EX material
available on your XDCAM HD device more easily than
the export function (see page 23).

Copied files have the same recording format as that of the
existing files in the destination.! However, the bit rates are
determined as specified in [Bit Rate] under [MP4 to MXF
conversion by copy] in the Conversion tab of the User
Configuration dialog (see page 35).

1) If no file exists in the destination, the bit rate is determined as specified in
[Format Settings: when there’s no clip in the folder] under [MP4 to MXF
conversion by copy] in the Conversion tab of the User Configuration
dialog.

Supplement

When the [Convert in MXF for copying EX to a normal
folder] check box in the General tab of the User
Configuration dialog (see page 34) is checked, even the
files which are to be copied to a normal folder are
converted to the MXF format. Since the clip management
folders for the XDCAM HD device (see page 33) are
automatically created, the files converted in this
application can be viewed. (The files which were output to
anormal folder by the export function cannot be viewed in
this application.)

* Itis not possible to convert the XDCAM HD files to the
XDCAM EX format.

Clip Operations
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* File conversion is not possible depending on the
combination of source format and target format.

* File conversion may degrade the image quality.

* This copy operation takes longer to complete since it

requires format conversion.

XDCAM EX to XDCAM HD format conversion

produces only MPEG HD files as MXF files. It does not

produce Proxy files.

To copy all the clips in media or folders

You can copy all of the clips in a folder or a media disc or
card in a single operation. This is a convenient way to
import all the clips in an SxS memory card to the hard disk
of your computer.

1 In the Tree View pane of an Explorer window, select
the media or folder that contains the clips you want to

copy.
2 Do one of the following.

* Click the Copy All button.
* Select [Copy All] from the [Edit] menu.

A message appears asking if you want to execute the
copy. Check the destination folder.

You can change the copy destination folder. See “User
settings” (page 34) for more information.

f XDCAM EX Clip Browser )

3 Click the [Yes] button to execute the copy, or the [No]
button to cancel it.

A dialog illustrating the progress of the copying opens
when the copying starts.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail

Copy operations may fail for the following reasons. In

these cases, an error message appears and the copy is

not executed.

* There is not enough free capacity at the copy
destination.

* A clip with the same name as one of the selected
clips already exists at the copy destination. Even if
the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* You do not have delete/write privileges to the
destination media or folders.

* The destination media or folder is write protected.

Clip Operations

Copy error check option

For greater copy reliability, you can enable the CRC
(cyclic redundancy check) error check option. However,
copy operations take longer to complete when this option
is enabled.

See “User settings” (page 34) for more information about
this option.

Moving clips

You can move clips on your media or computer, and move
clips between media and the computer.

* You cannot operate clips in other than XDCAM EX
format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* Clips with OK status can be moved by this application.

Grouping split clips by gathering them into one
place

XDCAM EX devices automatically save video that
exceeds 4 GB in size as multiple clips. If you collect these
clips into one media or folder, they are automatically
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate
media” (page 21) for more information.

Move modes

You can specify whether to give priority to processing

speed or to data protection when moving clips.

* Processing speed: Normal move processing, without
creating a duplicate of the clip.

 Data protection: A duplicate of the clip is created before
the original clip is deleted.

See “User settings” (page 34) for more information about
the settings.

1 Selecta clip to move in the List View pane of an
Explorer window.

* Abnormal clips can be selected, but they cannot be
moved.

* The folder that contains the selected clips cannot be
specified as the move destination.

If you want to move the clips to a new folder
Create a new folder in the move destination media or
folder.



See “Creating folders” (page 29) for more
information about how to create folders.

Do one of the following.

* Drag the clips selected in step 1, and while holding
down the Shift key, drop them in the List View pane
of another window, or on a copy destination media
or folder in the Tree View pane of the same window
or another window.

* Click the Cut button. Then click the List View pane
of another window, or a copy destination media or
folder in the Tree View pane of the same window or
another window, and click the Paste button of that
window.

¢ Select [Cut] from the [Edit] menu. Then click the
List View pane of another window, or a copy
destination media or folder in the Tree View pane of
the same window or another window, and select
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the
move.

| XDCAM EX Clip Browser |

Click the [ Yes] button to execute the move, or the [No]
button to cancel it.

A dialog illustrating the progress of the move opens
when the move starts.

* Once it has been completed, you cannot undo the
move operation.

* Do not exit this application during the move. Doing
so can break the links between clips and their
metadata. The link information for split clips can be
lost, causing them to become abnormal clips. If the
selected clips are important, we recommend that you
set the move mode to data protection mode (see page
20).

To cancel the move operation
Click the [Cancel] button in the progress dialog.

Reasons why a move operation may fail

Move operations may fail for the following reasons. In

these cases, an error message appears and the move is

not executed.

* There is not enough free capacity at the move
destination.

* A clip with the same name as one of the selected
clips already exists at the move destination. Even if

the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* You do not have delete/write privileges to the source
or destination media or folder.

 The source or destination media or folder is write
protected.

Deleting clips

 Clips with OK status can be deleted by this application.
 Deleting a clip linked to edit lists deletes all the edit lists
linked to the clip.

1 In the List View pane of an Explorer window, select a
clip to delete.

2 Do one of the following.

* Press the Delete key.
* Click the Delete button.
¢ Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to
delete the clips.

[ xDCAM EX Clip Browser 2]

m The clip will be delsted Iz
b &

3 Click the [Yes] button to execute the deletion, or the
[No] button to cancel it.

It is not possible to undo the deletion once it has been
completed.

Reasons why a delete operation may fail

Deletion operations may fail for the following reasons.

In these cases, an error message appears and the

deletion is not executed.

* You do not have delete/write privileges to media or
folder where the clips are stored.

* The media or folder where the clips are stored is
write protected.

Grouping clips that have been split
across separate media

When you have split clips that have been saved on separate
media as a result of an extended recording session, you can
group those clips by collecting them in a single location.

Clip Operations
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Grouped clips can be handled as a single clip. You can
collect split clips by copying them, by moving them, or by
combining split folders.

See “Copying clips” (page 18), “Moving clips” (page 20),
and “Combining folders” (page 31) for more information
about the operations.

* You cannot operate clips in other than XDCAM EX
format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* Split clips which are not continuous along the time axis
are not grouped.

* Abnormal clips are not grouped.

* Clips with altered UMIDs are not grouped. Grouping is
performed on the basis of the UMIDs of split clips, and
not on the basis of their file names.

Creating clips by specifying ranges

You can create a new clip by setting In and Out points in
an existing clip. The new clip can be handled in the same
way as the original clip. This is a convenient way to create
clips during online editing.

You cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 Previewa clip in a Preview window (see page 25),
click the Mark In button at the position you want to use
as the first frame, and click the Mark Out button at the
position you want to use as the last frame.

In and Out points are set in the clip.

Supplement

You can also set the Out point by specifying the In
point and duration.

Duration can be specified by clicking the timecode
display of the duration, entering a numeric value, and
pressing the Enter key.

In and Out points cannot be set at the same frame.
When you try to set an Out (or In) point at a frame
where an In (or Out) point has been set, the Out point

is automatically set at the next frame after the In point.

2 Play the section specified in step 1, and adjust the In
point and Out point positions as required.

Clip Operations

3 In the List View pane of an Explorer window, find the
clip where you set the In and Out points, and click the
clip to select it.

To create several clips in one batch operation
You can create several clips in one operation.

Carry out steps 1 and 2 in several clips stored in the
same folder or on the same media, and then select
those clips here.

4 From the [Clip] menu, select [New clip using In/Out
section].

A confirmation message appears asking if you want to
create the clips.

| XDCAM EX Clip Browser ||

ﬁ,\l A will be treated, st OK?
©

If the In and Out points are not set

The following message appears. If you choose to
continue, the effect is the same as copying the
complete original clip.

" XDCAM EX Clip Browser =

F,\‘ Mark In and Mark Out are setat ihe beginning and the end of the clip respectively.
\ &/ Thewhole clipwil be copied. Is if GK?

T Yes " No

5 Click the [Yes] button to create a new clip, or the [No]
button to cancel the operation.

A progress dialog opens when creation of the clip
starts.

To cancel creation of the clip
Click the [Cancel] button in the progress dialog.

Reasons why a new clip operation may fail

Creation of a new clip may fail for the following

reasons. In these cases, an error message appears and

the clip is not created.

 There is not enough free capacity at the clip creation
destination.

* You do not have delete/write privileges to the
destination media or folders.

Importing clips

You can import XDCAM EX format compatible MP4 files
and register them as clips that can be handled by XDCAM
EX devices.



You cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 In the Tree View pane of an Explorer window, select
the media or folder that contains the MP4 files to be
imported.

2 Do one of the following.

* Select [Import...] from the [File] menu.
* Right click the media or folder and select [Import...]
from the context menu.

The Import dialog opens.

- = -
& mport
Lockin: ) Documerts >~ @F =@
Name Date modif.. Type Size Tags
I |
o I Sony
Recent Places |
Desktop
0
BU
i
Computer
P
-
Netwark
il name: - Start
Fies of type: WMP4 - MPEG-4 Movie -] [ cancel ]

3 Select MP4 files to import.

4 Click the [Start] button to start the import, or the
[Cancel] button to cancel it.

A dialog illustrating the progress of the import
operation opens when the import starts.

To cancel the import operation
Click the [Cancel] button in the progress dialog.

Reasons why an import operation may fail

File import operations may fail for the following

reasons. In these cases, an error message appears and

the files are not imported.

* You do not have delete/write privileges for the
import destination media or folder.

* The import destination media or folder is write
protected.

* The properties of imported clips are set
automatically.

* The format of imported clips is not fully compatible
with the XDCAM EX format. It may not be possible

to play imported clips on XDCAM EX devices and
with this application.

Exporting clips

You can export files created on XDCAM EX devices for
use in various other environments. (To export is to convert
files into other formats and output them.)

Future versions will support additional video formats. For
upgrade information, visit the website listed in the
“Features” section of the Operating Instructions for your
XDCAM EX device and on the cover page of the supplied
CD-ROM.

Y ou cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 In the List View pane of an Explorer window, select a
clip to export by clicking them.

2 Do one of the following.

¢ From the [File] menu, select [Export] and then select
the format that you want to convert to.

» Right click the clip, from the context menu, select
[Export] and then select the format that you want to
convert to.

See “File conversion formats” (page 24) for more
information about the available conversion formats.

An export dialog opens for the selected format. (The
figure below shows the dialog that opens when you
choose [MXF for XDCAM HD422].)

3 Change the following settings as required.

Export to: Specifies the export destination folder.
Enter a path beginning with a drive name in the
edit box. Or click the [...] button to open a browse
dialog where you can select a folder, and then
click the [OK] button.

Clip Operations
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Make sure that the export destination media has
adequate free space before you execute the
export. An error occurs at the point where the free
space is used up.

Type: Click the [Details...] button to open the Codec
Detail dialog, set parameters as required, and then
click the [OK] button. This item does not appear
for some conversion formats.

Codec Detail

Type: XDCAM HD422

When “1CH” is selected in the [Channel] list box
of the [Audio] section, a mixed signal of the
channels 1 and 2 is output.

Target of Export: Select [In/Out section] if you want
to output the range between the In and Out points
in the current clip. This item does not appear for
some conversion formats.

To change the output file name

In the List View pane, do one of the following to make

the file name changeable.

* Click the file name.

* Right click the highlighted part to display the
context menu and select [Modify the output
filename] from the context menu.

Enter a new name, and press the Enter key or click
anywhere other than the file name. Extension does not
need to be entered.

Click the [Execute] button to start the export.

A progress bar appears to show the progress of the
export. The progress also appears in the [Status]
column of the List View pane.

To cancel the export
Click the [Cancel] button.

If a file with the same name already exists at the
output destination

A dialog appears to ask how you want to proceed.
Read the explanation in the dialog and click one of the
buttons.

Clip Operations
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* The optional MainConcept plug-in software must be
installed to use some conversion formats (see page 44).
If the plug-in is not installed, a watermark appears in the
exported video, and audio is saved for the first 30
seconds only (the subsequent audio is muted).

* Depending on the specified parameters, image quality
may be degraded due to the image compensation
process.

» Converted files may not be exactly the same with native
files in the target format.

* Video metadata may not be inherited after format
conversion.

* Image quality may be degraded if format conversion
requires re-encoding.

* Image quality may be degraded and duration may vary if
files are converted to a format with a different bit rate,
resolution, or frame rate parameters.

» Before exporting, ensure that the export destination
media or folder is write enabled.

File conversion formats

File conversion formats can be selected with the Export
subcommands in the following table.

Export Extension |Description
subcommand | after

conversion
MXF for NLEs @ | mxf Converts to MXF file format

without changing the bit
rate, resolution or other
parameters. This is for non-
linear editors that support

MXF files only.
MXF for mxf Converts to an MXF format
XDCAM HD ) ©) that is compatible with MXF
files recorded by XDCAM
HD devices.
MXF for XDCAM | mxf Converts to an MXF format
HD422 b). d) that is compatible with MXF
files recorded by XDCAM
HD422 devices.
MXF for XDCAM | mxf Converts to an MXF format
MPEG IMX © that is compatible with MXF

files recorded by XDCAM
MPEG IMX devices.




Export Extension | Description Export Extension |Description
subcommand | after subcommand | after
conversion conversion

MXF for XDCAM | mxf Converts to an MXF format Apple iPod mp4 Converts to a format that
DVCAM © that is compatible with MXF (H.264/AVC) 9) allows clips to be

files recorded by XDCAM previewed on the iPod

DVCAM devices. portable media player from
Raw DV dv Converts to RAW DV Apple Inc.

format.This is for DV format Video hosting wmv Converts to a format

editing. Depending on the service optimized for Internet video

editing environment, use hosting services.

either this subcommand or

the [AVI DV] subcommand. a) When outputting the range between the In and Out points in the current

- clip, the duration may be prolonged after conversion.
AVI DV avi Converts to AVI Type-2 b) Clips of two seconds or less can be converted to MXF files, but they
format.This is for DV format cannot be written to export destination devices.

editing. Depending on the ¢) 23.98p clips can only be converted to a format with the same frame rate

editing environment, use (23.98p).

either this subcommand or d) 23.98p clips cannot be converted.

the [RAW DV] e) This application supports copying, deleting, and viewing properties of

subcommand XDCAM MPEG IMX or XDCAM DVCAM clips. It does not support

: previewing and the other operations. Thumbnail creation fails.
Avid AAF P AAF/mxf Converts to the following f) Avid editing systems may refuse to import a clip that has already been
two file formats. exported to the editing system.
AAF file: Use to load clips g) Improper playback may occur if the converted file is viewed on a viewer
into ;Avid editing other than the specified devices.
system. The extension
is AAF, and the output
destination is the i i i
e o Previewing clips
specified in the Export . . . .
d?alog (see page 2%)_ You can preview clips in the Preview window.
AAF files produced by
the conversion can be Several limitations apply to playback in the Preview
f%gt'?»tered Itn your AV'? window. For details, see “Notes about the Preview
editing system projec . »
by dragging from window” (page 15).
Windows Explorer to a
bin in the project. : : : :
MXF OPAtom file: The To load clips in the Preview window
extension is mxf, and Display the clip that you want to preview in the Clip View
the output destination pane of an Explorer window, and then do one of the
is the media or folder :
P following.
specified in the . .
Conversion tab of the * Double click the clip.
User Configuration ¢ Click the clip and then press the Enter key.
dialog (see page 35). * Drag and drop the clip on a Preview window (this
Norma;lyl this |fs the operation is disabled if multiple clips are selected).
media folder of your * Right click the clip and select [Play] from the context
Avid editing system
project. menu. _
For details, refer to the ¢ Click the clip and then press the space key.
user’s manual of your
editing system. The clip is loaded into a Preview window (and, when the
Windows Media | wmv Converts to Windows fourth or fifth operation as stated above has been done, the
File Media Player 9 compatible playback starts). The timecode of the current playback

format. position (or a counter value) appears in the upper part of
Sony PSP mp4 Converts to a format that the screen, together with the duration of the section

(H.264/AVC) 9)

allows clips to be
previewed on the
PlayStation Portable (PSP)
game console from Sony
Computer Entertainment.

between In and Out points in the clip.

To stop play
Click the play button.

Clip Operations
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Smooth playback is not possible when previewing clips
saved to DVD-R or CD-R discs.

To control the preview

You can use the following methods to control playback in
the Preview window.
» Use the command buttons (see page 16) in the Viewer
window.
* Select an operation from the [Play] menu.
* Drag the playline.
* Press the J, K, or L key.
J: Change the reverse playback speed. Each press selects
-1, -2, -4, -8, or —16 times normal speed.
K: Stop playback.
L: Change the forward playback speed. Each press
selects 1, 2, 4, 8, or 16 times normal speed.

No audio is output in playback at speeds greater than +4
times normal speed.

To select full-screen playback

Double click the screen, or select [Full Screen] from the
[View] menu.

To return to the original screen size, double click the
screen or press the Esc key.

To change the playback mode of MXF clips
Select “MPEG HD (high resolution)” or “Proxy (low
resolution)” in the Play tab of the User Configuration
dialog (see page 35).

Selecting “MPEG HD” makes it possible to preview with
high definition images when the screen size is enlarged.

* You cannot change the playback mode when a clip is
being played.

* Clips without proxy AV data are played at a high
resolution regardless of this setting.

* Clips on XDCAM drive are played at a low resolution
regardless of this setting.

* High resolution data may not be played smoothly due to
its large file size.

To select the audio channels to monitor during
previews

In the Set Audio Channels dialog, check the L (left) or R
(right) check box to monitor that channel.

To open the Set Audio Channels dialog, do one of the
following.

* Select [Set Audio Channels...] from the [Play] menu.

* Click the Set Audio Channels button.

Clip Operations

[ Set Audio Channels %

R
|
V]
L |
H|
[ |

[ L R
I |

To edit essence marks

Use the Edit Essence Marks dialog.

To open the Edit Essence Marks dialog, load a clip into a
Preview window, activate the Preview window, and select
[Edit Essence Marks...] from the [Edit] menu.

li Edit Essence Marks

" cancel

y
* _Shathark!

Essence marks in clips on XDCAM drives cannot be
edited.

To edit a comment: Select an essence mark in the list and
click the [Edit] button. This opens the Edit Comments
dialog. Edit the comment in the dialog and click the
[OK] button. The maximum length of comments is 32
bytes. The edited comment appears in the Comment
field of the Edit Essence Marks dialog.

i Edit Commenis

Shotharki

To delete an essence mark: Select an essence mark in the
list (you can select multiple essence marks by
selecting with the Ctrl or Shift key held down) and
press the [Delete] button.

To confirm changes: Click the [OK] button in the Edit
Essence Marks dialog.

To discard changes: Click the [Cancel] button in the Edit
Essence Marks dialog.



» The only essence marks that can be displayed on
XDCAM EX devices are “_ShotMark1” and
“_ShotMark2”.

* During playback on XDCAM EX devices, essence
marks set by this application are displayed next to the
frames where they were set.

Changing the index picture of a clip
You can change index pictures during clip previews.

1 Play a clip, and display the frame you want to use as
the index picture.

2 Select [Set Index Picture] from the [Edit] menu, or
click the Set Index Picture button.

The currently displayed frame becomes the clip’s
index picture, and the Index Picture in the General tab
of the clip properties section changes to show it.

* If you are previewing a clip that is stored on
removable media, do not eject the media until the
operation finishes.

* Do not power the computer off until the operation
finishes.

* On XDCAM EX devices, a frame near the specified
frame may be displayed as the index picture, instead
of the specified frame itself.

* If you press the Set Index Picture button during play
of the clip, the thumbnail view may show no change
before the play is finished.

Creating still images

1 Play a clip in an Explorer window, and stop at the
scene you want to use as the still image.

2 Do one of the following.

* Press the Capture Still Image button.

* Select [Capture Still Image...] from the [File] menu.

A dialog opens in which you can specify the file name
and storage destination.

3 Specify the file name and storage destination and click
the [OK] button.

A bitmap still image is created from the frame selected
in step 2.

It is not possible to create still images from a clip on
XDCAM disk.

Searching for clips

You can search for a clip in either of the following ways,

depending on whether you know where the clip is located.

Folder search: When you know where the clip is located,
you can search a specified folder for clips with
specified properties.

Keyword search: When you know only the fact that the
clip is located on the computer on which this
application is installed, you can perform a keyword
search.

Always observe the following precautions during a search.
* Do not delete the target folder.
* Do not eject the target media.

1 Activate an Explorer window and do one of the
following.

¢ Click the Find button.
¢ Select [Find...] from the [Edit] menu.

The Find dialog opens.
2 Specify search criteria.

Specified Folder tab

Status Folder Pain

To search a different folder: Click the [...] button to
open a browse dialog, select the target folder, and
click the [OK] button.

To specify search criteria: Select at least one item
from the [Items] list, and enter the matching
condition in the text box for that item, or select the
condition from the list.

To specify the type of search: Click “Include all
keywords” (AND search), “Include any of the
keywords” (OR search), or “Exclude keywords”
(NOT search).

Clip Operations
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To specify search options: As required, check “Case
sensitive” and “Narrow down search” (narrow
down the search within the results of the previous
search).

When [Clip Name] is selected from the [Items] list,
search is performed based on the [Clip Name] settings
in the Display tab of the User Configuration dialog.

Keyword Searching tab

* On Windows XP, keyword search is available only
when the latest version of Windows Desktop Search
is installed.

» Keyword search uses Windows Desktop Search, so
the search results depend on the functionality of
Windows Desktop Search.

* Windows Desktop Search is an indexed search

system. The index is updated at times when the

computer is not being used for other tasks.

Therefore, even if clips exist on the hard disk of the

computer, they will not be found if they have not yet

been indexed.

Before performing a keyword search, register

folders that contain clips in the Windows Desktop

Search Options dialog, so that Windows Desktop

Search will index the clips.

Refer to the Windows help for more information
about Windows Desktop Search operations.

¢ The drives of XDCAM HD devices are not searched.

To specify the keywords to find: Enter the keywords
to find in the Keywords box. You can enter
multiple keywords. An AND search is performed
(partial match). Uppercase and lowercase are not
distinguished.

Click the Start button.

A list of search results appears in the Find dialog,
containing clips that match the conditions specified in
step 2.

Clip Operations

To hide the search criteria in the Specified Folder
tab

Click the “~” button.

Click the “+” button when conditions are hidden to
show them again.

To sort the search results

Click the header of the column that you want to use as
the sort key.

With each click, the list is sorted in ascending or
descending order.

To display the search results in an Explorer

window

Select one of the search results and do one of the

following.

* Select [Go to Explorer] from the [Find] menu.

* Right click the result and select [Go to Explorer]
from the context menu.

To play the search results

Select one of the search results and do one of the

following.

* Select [Play] from the [Find] menu.

» Right click the result and select [Play] from the
context menu.



Folder and Media
Operations

Folder and media precautions

Always observe the following precautions during

processing of folder and media operations.

* Do not power off the computer or media drive before the
operation completes.

* Do not eject the media before the operation completes.

Folders for XDCAM EX clips

XDCAM EX clips are stored together with a BPAV folder
(see page 32). (This folder does not appear in the Explorer
window, but it can be seen in Windows Explorer.)
Whenever you copy or move clips with this application,
the BPAV folder is copied or moved along with the clips.
You cannot work with clips separately from the BPAV
folder.

Simultaneous access to files may not be possible when you
attempt to access the same folder at the same time from
several computers over a network connection.

Folders for MXF clips

A folder for managing MXF clips must have three

subfolders: Clip, Edit, and Sub (see page 33). Clips cannot

be saved in the Clip subfolder unless they match the clips

existing in that subfolder in terms of the following

characteristics.

* Frame rate (NTSC/PAL/24p)

* Codec (MPEG IMX/DVCAM/HDA4:2:0/HD4:2:2)

» Resolution width (coincidence of resolution height not
required).

* Bit rate when the codec is MPEG IMX

These conditions are determined by the format of the clip
first saved in the Clip subfolder. When copying MXF
clips, it is necessary to check the source clips and the clips
existing in the copy destination folder to be sure that these
conditions are satisfied.

Creating folders

1 In the Tree View pane of an Explorer window, select
the media or folder where you want to create the
folder.

2 Do one of the following.

¢ Click the New Folder button.

¢ From the [File] menu, select [Folder] and then select
[New Folder].

» Right click the media or folder and select [New
Folder] from the context menu.

A new folder is created in the media or folder selected
in step 1.

Reasons why folder creation may fail

Folder creation operations may fail for the following

reasons. In these cases, an error message appears and

the folder is not created.

* You do not have write privileges for the selected
media or folder.

* The selected media or folder is write protected.

* Folders cannot be created when writing is not allowed by
the computer file system.

¢ New folders are created as normal folders. But when
even one clip is copied or moved to the new folder, the
folder is formatted as an XDCAM EX or XDCAM HD
work folder. (The required subfolders and metadata files
are created automatically.)

To rename a folder

1 Select a folder and do one of the following.

¢ From the [File] menu, select [Folder] and then select
[Rename].

* Right click the folder and select [Rename] from the
context menu.

The folder name is selected, so that now you can edit
the name.

2 Enteranew name, and then press the Enter key or click
somewhere outside the folder name.

* The name “BPAV” is reserved and cannot be
specified.

* Characters forbidden by the operating system cannot
be used in folder names.

* A folder name comprised of 200 or more characters
may not be recognized.

To back up folders

1 In the Tree View pane of an Explorer window, select
the folder that you want to back up.

Folder and Media Operations
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2 Do one of the following.

* Select [Show in Windows Explorer...] from the
[File] menu.

* Right click the folder and select [Show in Windows
Explorer...] from the context menu.

Windows Explorer starts.

3 Perform your backup operations in Windows Explorer
by copying the folder to other media or to another
folder.

When a folder is too large to save to your backup
media or folder

You can split the folder into smaller folders, and save them
on separate discs. Split folders can later be combined to
restore the original large folder.

See “Splitting folders” (page 30) and “Combining
folders” (page 31) for more information.

Deleting folders

1 In the Tree View pane of an Explorer window, select
the folder to delete.

2 Do one of the following.

* Press the Delete key.

* Click the Delete button.

¢ Select [Delete] from the [Edit] menu.

* Right click the folder and select [Delete] from the
context menu.

A message appears asking if you want to execute the
deletion.

XDCAM EX Clip Brow ]

3 Click the [Yes] button to execute the deletion, or the
[No] button to cancel it.

Reasons why a folder deletion may fail

Folder deletion operations may fail for the following

reasons. In these cases, an error message appears and

folder is not deleted.

* You do not have delete/write privileges for the
selected folder.

* The selected folder is write protected.

* Clips or other folders exist beneath the selected
folder.

Folder and Media Operations

* Be careful when deleting folders, because all data in
the folder is deleted.
* Deletions cannot be undone after they finish.

1) The following examples show two situations in which a folder (Work1)
cannot be deleted.

When there is a file that is not managed by XDCAM EX devices

[ ] worki
[ " ]BPAv

E File not managed by XDCAM EX devices

When there is another folder (Work2)

Work2

BPAV

Normally, files which are not managed by XDCAM EX devices and
folders such as Work2 must be deleted before the folder Work1 can be
deleted. However, if you use Windows Explorer to create a folder or file
in Work1 while this application is running, then Work1 may be deleted
even while the folder or file still exists.

Splitting folders

You can split large folders into smaller folders. This allows
you to back up all of the clips in a large folder to media that
is not large enough to save the entire folder without
splitting.

For example, you can split an 8 GB folder into two 4 GB
folders in order to save them on 4 GB DVD-R media. Note
that individual files in the large folder are not split.

You cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 In the Tree View pane of an Explorer window, select
the folder to split.

2 Do one of the following.

¢ Click the Split Folder button.

* Select [Split Folder...] from the [Clip] menu.

 Right click the folder and select [Split Folder...]
from the context menu.

The Split Folder dialog opens.



[ Split Folder

Folder Name:
Material

Split Unit
Media: DWD1 Layer: i _:J

i/l 6B

The individual files in split folders are not split. Clips
are assigned to the split folders in such a way that the
split folders have the specified size. This means that it
is not possible to specify a split folder size smaller than
the largest file in the original folder. It is also not
possible to specify a split folder size smaller than 4
GB.

3 Select the type of media from the [Media] list box.

The size of the folder after splitting, as determined by
the selected media type, appears in the edit box
beneath the list box.

If you select “Arbitrary Size”, enter the size (an integer
from 4 to 100) in the edit box.

4 Click the [Start] button.

The folder is split into the minimum number of folders
that will produce the specified folder size, and clips are
assigned to the smaller folders. The folders produced
as a result of the split have the same name as the
original folder, followed by serial numbers.

* Once it starts, a split operation cannot be canceled
before it finishes.

* Split clips may be assigned to different folders. If
you would prefer that split clips be assigned to other
folders, you can move them manually after the
folder split.

Combining folders

You can combine specified folders into another folder.
This allows you to restore the original folder from split
folders.

* You cannot operate clips in other than XDCAM EX
format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* To become the target of combination, folders must
reside on the same directory level and be under the
management of this application (see page 32).

1 In the Tree View pane of an Explorer window, select
the destination folder, into which the other folders will
be combined.

2 Do one of the following.

 Select [Combine...] from the [Clip] menu.
» Right click the folder and select [Combine
Folders...] from the context menu.

The Combine Folders dialog opens.

" Combine Folders
Combined with:
Material
Target Folder

Esample

W Celetethe folder ster combine

3 Check the check boxes of the folders that you want to

combine into the folder selected in step 1. Check the
[Delete folders after combine] check box if you want
to delete the combined folders after the combine.

The combined folders are not deleted when:

* They contain other folders.

* You do not have delete/write privileges to the
original folders.

* The folders are write protected.

4 Click the [Start] button.

The folders selected in step 3 are combined into the
destination folder specified in step 1. The clips in all of
the folders are gathered into the destination folder. If
any of the clips are split clips, they are automatically
grouped, allowing them to be handled as a single clip.

Reasons why a folder combine operation may fail

Folder combine operations may fail for the following

reasons. In these cases, an error message appears and

the combine is not executed.

¢ There is not enough free capacity in the combine
destination folder.

* You do not have write privileges to the source or
destination folders.

* The source or destination folders are write protected.

Folder and Media Operations
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» Multiple instances of the same clip exist.

Checking/editing disc metadata
You can check and edit the disc metadata
(DISCMETA.XML) (see page 33) saved on XDCAM
drives or in folders with MXF attributes.

1 In the Tree View pane of an Explorer window, select
an XDCAM drive or a folder with MXF attributes.

2 Do one of the following.

¢ Select [Edit Disc Metadata...] from the [Edit] menu.

* Right click the XDCAM drive or folder with MXF
attributes and select [Edit Disc Metadata...] from
the context menu.

The Edit Disc Metadata dialog opens.

" Edit Disc Metadata

Disc ID: B8DE0B00073905C1FECI0B0046020120

User Disc ID:

1R R XD CAM HD Demo Disc (599.940)

BT Demaonstration use only

" cancel

3 Edit the following items as required.

» User Disc ID (up to 127 bytes)
* Title 1 (up to 63 bytes)

* Title 2 (up to 127 bytes)

* Description (up to 2047 bytes)

4 Click the [OK] button.

Appendix

Appendix

How XDCAM EX clip data are
configured

Recording format

This application supports the format specified for

XDCAM EX devices. This format has the following

specifications.

* Folder names and the folder configuration are as shown
in the following figure.

* Files contain link information pertaining to links
between files and folders.

* Do not use tools that do not support the XDCAM EX
format to edit, delete, move, or rename the files and
folders used by this application. Unless the format
specifications are observed, files can become unreadable
by XDCAM EX devices and by this application.

* It may not be possible for XDCAM EX devices to play
clips that this application has created on, copied to, or
moved to media other than SxS PRO memory cards.

Recording folders

The configuration of video and metadata folders is as
shown in the following figure.

In the XDCAM EX format, the data beneath the BPAV
folder is handled as a single set of data.

Media or work folder

| =] MEDIAPRO.XML

CUEUPXML
—{ JcLpr

—(

—(
—{=)ABC0000.MP4
—{ ] TAKR

—(




* One BPAYV folder exists when a work folder is opened in
Windows Explorer.

* To copy and backup your data, select the folders beneath
the BPAYV folder.

* When a work folder is selected in a Tree View pane of
Explorer window, a list of clips registered in the BPAV
folder appears in the corresponding List View pane. AV
data is saved in the folders beneath the CLPR folder.

* On the media used by XDCAM EX devices, the BPAV
folder is created beneath the root folder of the media.

* When a work folder is selected in a Tree View pane of
Explorer window and the CLPR folder in the work folder
has some MP4 files, new folders are created beneath the
CLPR folder, and the MP4 files are moved to those
folders (the effect is the same as importing the MP4
files).!

* When MP4 files are imported to a work folder, new
folders are created beneath the CLPR folder, and the
imported clips are moved to those folders. Folder names
are assigned automatically.

* On SxS memory cards and the PHU-60 Professional
Hard Disk Unit, up to 600 clips can be registered in one

recording folder.
1) This process does not work in the UserData folders on XDCAM drives.

Folder and file names are linked to metadata files. Do not
change them.

How MXF clip data are configured

Recording format

This application supports the format specified for

XDCAM HD devices. This format has the following

specifications.

* Folder names and the folder configuration are as shown
in the following figure.

* Files contain link information pertaining to links
between files and folders.

* Do not use tools that do not support the XDCAM HD
format to edit, delete, move, or rename the files and
folders used by this application. Unless the format
specifications are observed, files can become unreadable
by XDCAM HD devices and by this application.

* It may not be possible for XDCAM HD devices to play
clips that this application has created on, copied to, or
moved to media other than Professional Discs (XDCAM
drives).

Recording folders

The configuration of video and metadata folders is as
shown in the following figure.

E‘:l Media or work folder

DISCMETA XML
MEDIAPRO.XML
( Tciip
=] ABC0000.MXF
=] ABCO00OMO1. XML
—{ ] Edit
—{ Jsub
—{ ] General
—{ T userData

* This application recognizes a folder containing the three
subfolders -- Clip, Edit, and Sub -- as a folder with MXF
attributes, and browses the Clip folder.

e If XDCAM Drive in the General tab of the User
Configuration dialog is set to “UserData,” this
application browses the UserData folder instead of the
Clip folder (see page 34).

« If file format conversion is executed by copying files to
a normal folder (see page 19), DISCMETA.XML and
MEDIAPRO.XML files, and Clip, Edit, Sub, and
General folders are automatically created, and then the
format-converted files are copied to the Clip folder. (For
example, when the file named ABC0000.MP4 is copied
to a work folder, the format is converted to MXF and the
files named ABC0000.MXF and ABCO000MO1.XML
are automatically created and saved in the Clip folder.)

* Folder and file names are linked to metadata files. Do not
change them.

* Even if you configure clip data like MXF clip data in an
EX folder using Windows Explorer or other file
management tools, this application gives priority to the
XDCAM EX format so that you cannot operate MXF
clips.

For details about the data configuration for MXF clips,

refer to the Operating Instructions or Operation Manual
supplied with the XDCAM HD device.
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User settings
The User Configuration dialog allows you to select
application options and processing modes.

To open the User Configuration dialog, select [Options...]
from the [Tool] menu.

General tab

I User Configuration

General Display | Play | Comversion

nosrmal folder

Copy all files to:

CilsersiBINDocumentsiSonaClipBrowser

Cancel

Priority in Move: Specifies whether to give priority to
operating speed or data protection when moving clips
(see page 20).

* Processing speed: Normal move processing, without
creating a duplicate of the clip

* Data protection: Creation of a duplicate before
deletion of the original clip

Convert in MXF for copying EX to a normal folder:
When EX format files are copied to a normal folder
(without EX or MXF attributes) with this check box
checked, the copies are automatically converted to the
MXEF format.

Perform CRC check after copy: When this check box is
checked, the application performs a CRC (cyclic
redundancy check) error check after copying a file,
and displays a message if a copy error is detected.

Copy all files to: Specifies the destination folder for the
Copy All command that copies all clips in a folder or
on a media disc or memory card (see page 20). Enter a
path beginning with a drive name in the edit box. Or
click the [...] button to open a browse dialog, select a
folder, and click the [OK] button.

Clip ID: Specifies up to four characters added to the start
of imported clip names, and to the name of the folder
where the imported clips are saved (see page 22).

XDCAM Drive: Specifies the folder on an XDCAM drive
that this application will use.

Appendix

¢ Clip: Uses the Clip folder. In this mode, only MXF
clips on the XDCAM drive can be operated
(XDCAM EX clips cannot be operated).

An “XDCAM Drive (normal)” icon is displayed in
the Tree View pane (see page 13).

e UserData: Uses the UserData folder. In this mode,
only XDCAM EX clips on the XDCAM drive can be
operated (MXF clips cannot be operated). This mode
is for backup of XDCAM EX clips.

An “XDCAM drive (UserData)” icon is displayed in
the Tree View pane (see page 13).

For details about the data management structure for the
XDCAM drive available in this application, see page 33.

Display tab

[ User Configuration

General 'Display Play | Cormversion

Clip Name
xocam B EEEDE

Lo U] By Filename |G

(7]

Cancel

Clip Name: Specifies what to display as the clip name for
each clip type.
By Title: Displays the title as the clip name.
* By Filename: Displays the file name as the clip
name.

Even if “By Title” is selected, the file name is
displayed for a clip with no title assigned.

50p/60p Timecode Display Mode: Specifies the
timecode display format when the frame frequency of
the playback clip is 50p or 60p.
* Show all frames: The frame number increases on
each frame. (Example of frame number display for
60p clips: 00— 01 — 02 — ... & 58 — 59— 00
—..)



* Show *: The frame number increases on every
second frame. An asterisk (*) is added to indicate the
second frame in each frame number pair. (This is the
display format used by Sony VTRs.) (Example of
frame number display for 60p clips: 00 — 00* —
0l > ..—29 —>29* > 00— ..)

When no more clips can be previewed: Specifies what to
do when the number of clips in Preview windows
(simultaneously open windows or tabs) exceeds the
number that can be previewed at one time.

* Show a warning.

* Replace the clip that was viewed first.

Play tab

I User Configuration

General | Display | Play | Conversion
| |

Resolution

MXF Play mode
® ypPEG HD
o

Resolution: Specifies the preview playback resolution.

* Auto: Decodes the playback video at a resolution
which is automatically adjusted to match the screen
size.

* Normal: Decodes the playback video at the original
resolution of the clip, regardless of the screen size.

* 1/2, 1/4: Decodes the playback video at half or
quarter resolution. The image quality is lower, but
response is better because of the lower demands
placed on the decoder.

MXF Play mode: Specifies the playback mode of MXF
clips.

* MPEG HD: Plays the clips at high resolution (plays
MXEF clips as is).

* Proxy: Plays the clips at low resolution (plays the
proxy AV data).

For notes on the playback mode of MXF clips, see page 26.

Conversion tab

" user Configuration

General | Display | Play | Conversion

Co

MP4 1o MXF conversion by copy
Bil Rate:
4:20 - v |
Format Setiings: when there’s no clip in the folder
{Note: This is not enabled if copying to an XDCAM device which has the systemn frequency)

prame ate: [N v | Format: I |

RAvid RAF
Qutput OPAtom files to:

4:2:2 [ETTTEN v |

Country: Specifies the video system adopted in the region
where the application is used.

* NTSC (Include 24p)

* PAL

MP4 to MXF conversion by copy: Specifies the
recording format to be used at the time of file format
conversion from MP4 to MXF by copy operation.

* Bit Rate
Specifies the bit rate of the converted file for each
color format when file format conversion is
performed by copy operation.

- 4:2:0: Selects 18Mbps, 25Mbps, or 35Mpbs.
- 4:2:2: Fixed to 50Mbps.

» Format Settings: when there’s no clip in the folder
Specifies the recording format (frame rate and
format) to be used when no clip exists at the copy
destination during file format conversion by copy
operation. The following combinations of the values
can be set.

Country Frame Rate |Format

NTSC (Include | 60i/60p/30p 4:2:0 18Mbps (x1080)

24p) 4:2:0 25Mbps (x720)

4:2:0 25Mbps (x1080)

4:2:0 35Mbps (x720)

4:2:0 35Mbps (x1080)

4:2:2 50Mbps

24p 4:2:0 18Mbps (x1080)

4:2:0 25Mbps (x1080)

4:2:0 35Mbps (x1080)

PAL 50i/50p/25p 4:2:0 18Mbps (x1080)

4:2:0 25Mbps (x720)

4:2:0 25Mbps (x1080)

4:2:0 35Mbps (x720)

4:2:0 35Mbps (x1080)

4:2:2 50Mbps
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For details about the file format conversion by copy
operation, see page 19.

Output OPAtom files to: Specifies the output folder for

The Media Creation dialog opens.

2 Specify the Video Drive/Audio Drive (media storage
drive) in the Import tab.

OPAtom files for the [Avid AAF] subcommand of the
Export command (see next item “To set the media
folder in Avid editing systems” ). Enter a path

beginning with a drive name in the edit box. Or click
the [...] button to open a browse dialog where you can 3

select a folder, and then click the [OK] button.

To set the media folder in Avid editing systems
For Avid Media Composer (V2.5.3 or later), proceed as

follows.

1 Select [Media Creation] from the [Settings] menu.

* Windows XP: Any hard disk drive
* Windows Vista: Any hard disk drive except the
drive where Windows Vista is installed

Import an MXF file into Avid Media Composer.

An “Avid Media Files\MXF\1” folder is created in the
drive specified in step 2.

Specify this folder in the [Output OPAtom files to]
box.

Menu list

This section lists the menus of this application as they
appear when application windows are activated.

In the Keyboard shortcut field, the notation “Ctrl + N”
means that the N key is pressed while holding down the

Ctrl key.
Main window is only open window
Menu Command Subcommand Keyboard |Function Reference
shortcut page
File Exit - Alt + F4 Exits this application. Page 9
View Message Options Reset to the default | - Subsequently displays the -
message box which was set to be
hidden by the setting of the [Do not
show this message in the future.]
check box.
Tool Options... - - Opens the User Configuration Page 34
dialog.
Window New Explorer Window - - Opens a new Explorer window. Page 11
New Preview Window - - Opens a new Preview window.
Help About Version... - - Displays the version of this -
application.
MainConcept Version... |- - Displays the version of the -
MainConcept plug-in software.
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Explorer window is active

Menu Command Subcommand Keyboard |Function Reference
shortcut page
File Folder New Folder Ctrl + N Creates a new folder in the Page 29 =——
currently selected media or folder. —
Rename Ctrl+ R Renames the selected folder. Page 29 T
Show in Windows - - Opens the selected folder in Page 29 %
Explorer... Windows Explorer, so that you can 3
back up the folder contents. %
Import... - - Imports an MP4 file to the selected | Page 22
folder.
Export MXF for NLEs... - Converts the selected clip to MXF | Page 23
format, for use on non-linear
editors.
MXF for XDCAM |- Converts the selected clip to
HD... XDCAM HD format.
MXF for XDCAM |- Converts the selected clip to
HD422... XDCAM HD422 format.
MXF for XDCAM - Converts the selected clip to
MPEG IMX... XDCAM MPEG IMX format.
MXF for XDCAM - Converts the selected clip to
DVCAM... XDCAM DVCAM format.
Raw DV... - Converts the selected clip to RAW
DV format.
AVI DV... - Converts the selected clip to AVI DV
format.
Avid AAF... - Converts the selected clip to Avid
AAF format.
Windows Media - Converts the selected clip to
File... Windows Media file format.
Sony PSP (H.264/ |- Converts the selected clip to a
AVC)... format for viewing on the
PlayStation Portable (PSP) game
console.
Apple iPod (H.264/ | - Converts the selected clip to a
AVC)... format for viewing on the Apple
iPod.
Video hosting - Converts the selected clip to a
service... format for uploading to video
hosting service.
Exit - Alt + F4 Exits this application. Page 9
Edit Cut - Ctrl + X Cuts the selected clip. Page 20
Copy - Ctrl+ C Copies the selected clip. Page 18
Paste - Ctrl+V Pastes a clip that has been cut or | Page 18
copied. Page 20
Delete - Delete Deletes the selected clip or folder. | Page 21
Page 30
Copy All - Ctrl + Shift | Copies all of the clips in the Page 20
+C selected media or folder.
Select All - Ctrl+ A Selects all of the clips in the -
selected media or folder.
Find... - Ctrl + F Opens the Find dialog. Page 27
Edit Disc Metadata... - - Opens the Edit Disc Metadata Page 32
dialog.
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Menu Command Subcommand Keyboard |Function Reference
shortcut page
View Command Bar - - Shows or hides the tool buttons. Page 12
Folder Tree - - Shows or hides the Tree View pane. | Page 12
Disk Space - - Shows or hides the disc capacity Page 13
display.
Status Bar - - Shows or hides the status Page 13
information of the selected clip.
Thumbnails - - Puts the List View pane into Page 13
thumbnail view mode.
List - - Puts the List View pane into list
view mode.
Details - - Puts the List View pane into details
view mode.
Sort by Clip Name - Sorts the clip list on the selected
Size _ key, in ascending or descending
order.
Duration -
Status -
Creation date -
Last Update -
Rec Mode -
Media Spanning -
Save Sort Order - Saves the current sort order for the |—
current folder.
Customize Columns... - - Opens the Customize Columns Page 15
dialog.
Message Options Reset to the default |- Subsequently displays the -
message box which was set to be
hidden by the setting of the [Do not
show this message in the future.]
check box.
Up - Backspace |Moves up one level in the folder -
hierarchy.
Refresh - F5 Refreshes the information displayed |-
in the active tab of the Explorer
window.
Clip New clip using In/Out - - Creates a new clip from the section | Page 22
section between In and Out points of the
selected clip.
Split Folder... - Ctrl + W Splits the selected folder into Page 30
folders of the specified size.
Combine Folders... - Ctrl +J Combines the selected folder to Page 31
another specified folder.
Play - Space Plays the selected clip. Page 25
Tool Options... - - Opens the User Configuration Page 34

dialog.
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Menu Command Subcommand Keyboard |Function Reference
shortcut page
Window New Explorer Window - - Opens a new Explorer window. Page 11
New Preview Window - - Opens a new Preview window. ——
Close Window - Ctrl + F4 Closes the active window. - —_—
New Tab - - Adds a new tab in the active - By
window. =
S
Close Tab - - Closes the active tab. - §.
Previous Tab - Ctrl + Selects the previous tab. Page 11 5
PageUp
Next Tab - Ctrl + Selects the next tab.
PageDown
Optimize Window Layout | — - Optimizes the positions of Explorer | Page 11
and Preview windows in the main
window.
Cascade - - Arranges the currently open -
windows in cascading order from
the upper left.
Tile Windows Vertically |- - Tiles the currently open windows -
vertically.
Tile Windows - - Tiles the currently open windows -
Horizontally horizontally.
Help About Version... - - Displays the version of this -
application.
MainConcept Version... |- - Displays the version of the -
MainConcept plug-in software.
Preview window is active
Menu Command Subcommand Keyboard |Function Reference
shortcut page
File Capture Still Image... - - Creates a bitmap still picture from | Page 27
the frame at the current position.
Exit - Alt + F4 Exits this application. Page 9
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Menu Command Subcommand Keyboard |Function Reference
shortcut page
Edit Cut - Ctrl + X Cuts the selected text in the clip Page 17
properties section of the General
tab.
Copy - Ctrl+ C Copies the selected text in the clip
properties section of the General
tab.
Paste - Ctrl+V Pastes text that was cut or copied in
the clip properties section of the
General tab.
Delete - Delete Deletes the selected text in the clip
properties section of the General
tab.
Set Index Picture - P Sets the frame at the current Page 27
position as the index picture.
Mark In - | Sets an In point at the current Page 22
position.
Mark Out - o Sets an Out point at the current
position.
Clear Mark In - Shift + | Clears the In point.
Clear Mark Out - Shift + O Clears the Out point.
Clear Mark In/Out - Shift + X Clears the In and Out points.
Add Essence Mark - E Sets an essence mark at the -
current position (up to 126).
Delete Essence Mark - Shift + E Deletes the essence mark at the -
current position.
Edit Essence Marks... - - Opens the Edit Essence Marks Page 26
dialog.
View Full Screen - Alt + Enter | Puts the Viewer into Full Screen Page 16

mode.

Message Options

Reset to the default

Subsequently displays the
message box which was set to be
hidden by the setting of the [Do not
show this message in the future.]
check box.
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Menu Command Subcommand Keyboard |Function Reference
shortcut page
Play Play - L or space | Plays the selected clip. Page 25
Stop - K or space | Stops clip play.
Play Reverse - J Plays the selected clip in the
reverse direction.
Play In to Out - Shift + Plays the range from the In point to
space the Out point of the selected clip.
—1 Frame - “«— Steps one frame back.
+1 Frame - — Steps one frame forward.
Jump to Start - Home Jumps to the clip start point (first
frame).
Jump to End - End Jumps to the clip end point (last
frame).
Jump to In Point - 1 Jumps to the In point.
Jump to Out Point - i Jumps to the Out point
Previous Essence Mark |- Shift + «— | Jumps to the previous essence
mark.
Next Essence Mark - Shift + — | Jumps to the next essence mark.
Set Audio Channels... - - Opens the Set Audio Channels Page 26
dialog.
Tool Options... - - Opens the User Configuration Page 34
dialog.
Window New Explorer Window - - Opens a new Explorer window. Page 11
New Preview Window - - Opens a new Preview window.
Close Window - Ctrl + F4 Closes the active window. -
Close Tab - - Closes the active tab. -
Previous Tab - Ctrl + Selects the previous tab. Page 11
PageUp
Next Tab - Ctrl + Selects the next tab.
PageDown
Optimize Window Layout |— - Optimizes the positions of Explorer | Page 11
and Preview windows in the main
window.
Cascade - - Arranges the currently open -
windows in cascading order from
the upper left.
Tile Windows Vertically |- - Tiles the currently open windows -
vertically.
Tile Windows - - Tiles the currently open windows -
Horizontally horizontally.
Help About Version... - - Displays the version of this -
application.
MainConcept Version... |- - Displays the version of the -
MainConcept plug-in software.
Find window is active
Menu Command Subcommand Keyboard |Function Reference
shortcut page
File Exit - Alt + F4 Exits this application. Page 9
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Menu Command Subcommand Keyboard |Function Reference
shortcut page
View Search Criteria - - Shows or hides the search criteria. | Page 27
Sort by Clip Name - Sorts the results list on the selected
Size _ key, in ascending or descending
order.
Duration -
Status -
Creation date -
Last Update -
Rec Mode -
Media Spanning -
Folder Path -
Message Options Reset to the default |- Subsequently displays the -
message box which was set to be
hidden by the setting of the [Do not
show this message in the future.]
check box.
Find Start - - Starts the search. Page 27
Stop - - Stops the search.
Go to Explorer - - Opens the selected clip in an
Explorer window.
Play - - Plays the selected clip.
Tool Options... - - Opens the User Configuration Page 34
dialog.
Window New Explorer Window - - Opens a new Explorer window. Page 11
New Preview Window - - Opens a new Preview window.
Close Window - Ctrl + F4 Closes the active window. -
Cascade - - Arranges the currently open -
windows in cascading order from
the upper left.
Tile Windows Vertically |- - Tiles the currently open windows -
vertically.
Tile Windows - - Tiles the currently open windows -
Horizontally horizontally.
Help About Version... - - Displays the version of this -
application.
MainConcept Version... |- - Displays the version of the -
MainConcept plug-in software.
Error and warning message list
Messages What to do

Failed to initialize OLE. Please confirm whether the OLE
library version is correct.

Failed to read libraries for Export.

There may be a problem with the installation of this application. Try
installing it again.
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Messages

What to do

The folder contains some incomplete clips. Please copy all
files in the [BPAV] folder under the selected folder to an
SxS card and execute salvage operation on the recording
equipment.

Incomplete clip exists. Please execute salvage operation
on the recording equipment.

Data on the media is incomplete, probably because the XDCAM
EX device was powered off during recording, or because the media
was ejected prematurely. Return the media to the XDCAM EX
device and salvage it immediately. The data may become
unrecoverable if you continue to operate without salvaging it.

Reason: The clip database is incorrect.

The XDCAM EX format may be corrupt. Try to salvage the material,
for example by importing an MP4 file to another folder.

The clip cannot be displayed in Explorer.

Check the properties of the selected clip. It cannot be imported or
displayed in the list because the format is not compatible with the
XDCAM EX format.

Failed to save sort order.

Try restarting this application, or restarting the computer. If the
problem persists, install the application again.

The clip database is incorrect, so it cannot be copied.

The clip database is incorrect, so it cannot be moved.

Failed to update properties.

The XDCAM EX format may be corrupt. Try to salvage the material,
for example by importing an MP4 file to another folder.

A file exceeding 4 GB needs to be split, so the file cannot
be copied.

A file exceeding 4 GB needs to be split, so the file cannot
be moved.

Files larger than 4 GB cannot be managed on media like the SxS
memory cards used by XDCAM EX devices. Use editing software
or some other tool to split the file into files smaller than 4 GB and
then try again.

Failed to create a clip.

The operation was cancelled for one of the following reasons.

* You do not have delete and write privileges to the selected media
or folder, or these operations are inhibited.

e The data is in an incompatible format, or it is corrupt.

Check the properties of the media or folder.

Reason: Unmatched frame rate.

The selected clip cannot be copied due to difference in frame rate
between that clip and clips existing in the copy destination folder.
Check the frame rate (NTSC/24p/PAL) of the clip you want to copy
and then perform copy by selecting a destination folder in which all
the existing clips are of the same frame rate as the selected clip.

Reason: The video format is different.

The selected clip cannot be copied due to difference in resolution
between that clip and clips existing in the copy destination folder.
Check the resolution of the clip that you want to copy and then
perform copy by selecting a destination folder in which all the
existing clips are of the same resolution as the selected clip.

Reason: Default format hasn’t been set. Please check
Conversion tab in User Configuration.

Set the frame rate and bit rate in the [Rates to apply when rec
format is unknown] section of the Conversion tab in the User
Configuration dialog.

Reason: Bit Rate hasn’t been set. Please check
Conversion tab in User Configuration.

Make settings in the [MP4 to MXF conversion bit rate] section of
the Conversion tab in the User Configuration dialog.

Reason: Failed to convert.

Check the recording format of the clip that you want to copy and
that of the clips existing in the copy destination folder. File
conversion may be disabled depending on the recording format of
the original clip and the clips in the copy destination folder.

Reason: The clip is less than 2 seconds, so it cannot be
written.

It cannot be copied because a Clip less than 2 seconds is
included.

XDCAM devices do not support writing of clips shorter than two
seconds.

UserData folder cannot be specified as the destination to
copy MXF files. Please change the Copy All destination in
User Configuration.

Change the setting in [Copy all files to:] of the General tab in the
User Configuration dialog.

Failed to import the clip.

Check the properties of the clip. You may not have access
privileges to the clip, or the clip may be an MP4 file that is not
compatible with the XDCAM EX format.

UserData folder cannot be specified as the output
destination.

Change the output destination.
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Messages

What to do

UserData folder cannot be specified as the destination to
output OPAtom files. Please change the OPAtom file
output destination in User Configuration.

Change the setting in [Output OPAtom files to:] of the Conversion
tab in the User Configuration dialog.
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The name is already used. Please specify other name.

Specify other name or change the output destination.

Error occurred during the export. Please refer to the
details from the context on each clip.

Open the export dialog to check the report which is displayed when
[Error detail] is selected from the context menu of the clip with the
error.

Reason: An error occurred during conversion.

The conversion failed for one of the following reasons.

* You do not have delete and write privileges to the output folder,
or these operations are inhibited.

* The selected clip is in an unsupported format, or the material
data is corrupt.

Check the properties of the folder and clip.

Reason: Unsupported XDCAM.

The selected XDCAM drive is not supported.

Reason: Unsupported codec.

The codec of the selected clip on the XDCAM drive is not
supported.

Failed to create a folder.

Check the properties of the selected media or folder. You may not
have delete and write privileges to the media or folder, or these
operations may be inhibited.

You cannot use [XXX] as a folder name. Please specify
another name.

Specify a name other than “BPAV”.

It contains a string reserved by the system, so it cannot be
set.

The name contains characters reserved by the operating system.
Enter a name that does not contain these characters.

Reason: The clip file name has already been reserved.

Change the file name or copy destination.

Failed to change the folder name.

Failed to delete the folder.

Failed to split the folder.

Check the properties of the selected folder. You may not have
delete and write privileges to the folder, or these operations may be
inhibited.

Failed to combine the folders.

Check the properties of the combine source or destination folder.
You may not have delete and write privileges to these folders, or
these operations may be inhibited.

[XXX] contains a work folder, so it cannot be deleted.

Reason: [XXX] has a sub folder.

The selected media or folder contains one or more folders that are
not under the management of this application. Delete or move
these folders and then try again.

The folder [XXX] cannot be split. Reason: The folder
contains a file exceeding the specified split unit of [XXX
GB]. Clip name:

The folder cannot be split into folders of the specified size because
at least one file larger than that size exists. Specify a split size that
is larger than the size of the largest file.

Failed to save disc metadata.

Check the properties of the selected XDCAM drive and the state of
the write protect tab on the disc. You may not have delete and write
privileges for the selected XDCAM drive, or these operations may

be inhibited.

How to obtain the plug-in software

The optional MainConcept plug-in software can be
purchased and downloaded from the following website.
http://www.mainconcept.com/plugin4clipbrowser

PERSONAL AND NONCOMMERCIAL USE OF A

CONSUMER FOR

(1) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”)

AND/OR

(ii))DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A

Licenses

MPEG-4 Visual Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE MPEG-4

VISUAL PATENT PORTFOLIO LICENSE FOR THE

Appendix

PERSONAL AND NON-COMMERCIAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED BY MPEG LA TO PROVIDE
MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE.




ADDITIONAL INFORMATION INCLUDING THAT
RELATING TO PROMOTIONAL, INTERNAL AND
COMMERCIAL USES AND LICENSING MAY BE
OBTAINED FROM MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/sales
of any storage media storing MPEG-4 Visual video
information (ii) distribution/broadcasting of MPEG-4
Visual video information in any manner (such as online
video distribution service, internet broadcasting, TV
broadcasting). Other usage of this product may be required
to obtain license from MPEGLA. Please contact MPEG
LA for any further information. MPEG LA, L.L..C., 250
STEELE STREET, SUITE 300, DENVER, COLORADO
80206, http://www.mpegla.com

MPEG-2 Video Patent Portfolio License

ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY MANNER
THAT COMPLIES WITH THE MPEG-2 STANDARD
FOR ENCODING VIDEO INFORMATION FOR
PACKAGED MEDIA IS EXPRESSLY PROHIBITED
WITHOUT A LICENSE UNDER APPLICABLE
PATENTS IN THE MPEG-2 PATENT PORTFOLIO,
WHICH LICENSE IS AVAILABLE FROM MPEG LA,
L.L.C, 250 STEELE STREET, SUITE 300, DENVER,
COLORADO 80206.

AVC Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC

PATENT PORTFOLIO LICENSE FOR THE

PERSONAL AND NON-COMMERCIAL USE OF A

CONSUMER TO

(1) ENCODE VIDEO IN COMPLIANCE WITH THE
AVC STANDARD (“AVC VIDEO”)

AND/OR

(i))DECODE AVC VIDEO THAT WAS ENCODED BY
A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR WAS
OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED

FOR ANY OTHER USE. ADDITIONAL

INFORMATION MAY BE OBTAINED FROM MPEG

LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM

VC-1 Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE VC-1

PATENT PORTFOLIO LICENSE FOR THE

PERSONAL AND NON-COMMERCIAL USE OF A

CONSUMER TO

(1) ENCODE VIDEO IN COMPLIANCE WITH THE VC-
1 STANDARD (“VC-1 VIDEO”)

AND/OR

(i))DECODE VC-1 VIDEO THAT WAS ENCODED BY
A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR WAS
OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE VC-1 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED

FOR ANY OTHER USE. ADDITIONAL

INFORMATION MAY BE OBTAINED FROM MPEG

LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM
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For Mac OS

How to use the application on Mac OS



Introduction

Purpose of this manual

This manual explains how to use the XDCAM EX Clip
Browsing Software on Mac OS. This manual is intended
for users who will use this application to perform file and
folder operations. It assumes that readers have a basic
familiarity with Mac OS.

Notation for special keys

This manual uses the following notation to indicate special
keys.

Symbol Notation in this manual
98 Command

AN Shift

\ Option

A Control

o) Return

Notes on use of XDCAM devices

* This software cannot access an XDCAM HD device
while another XDCAM-compatible application
(XDCAM Transfer/PDZ-1) is accessing that device.

* While running this software, if it becomes necessary to
connect/disconnect the i.LINK cable or power on/off the
XDCAM device, always do such operations after you
exit this software.

Overview

The XDCAM EX Clip Browsing Software allows you to
work with clips created with XDCAM EX/XDCAM HD
devices.

After installing this application on your computer, you can
use its intuitive graphical user interface to organize your
clips by copying, moving, and deleting them. You can also
perform format conversions, preview the clips, and view
their metadata.

This application supports XDCAM EX/XDCAM HD

compatible data.V

1) For XDCAM HD compatible data, executable operations are limited (see
next section).

New functions supported in Version
2.5

The following table shows the principal new functions
supported in Version 2.5.

Function Description Reference
XDCAM HD file You can operate -
operations XDCAM HD files (MXF

files).

However, the

operations are limited

to copying, deleting,

and previewing.
Converting EX files | You can convert Page 60
to MXF files by a XDCAM EX files (MP4
copy operation files) to MXF files by

only copying them to a

folder with MXF

attributes.
Extended export You can convert files to | Page 65
function XDCAM MPEG IMX

and XDCAM DVCAM

format files.

Hardware and software
requirements

Install this application on a computer meeting the
following hardware and software requirements.

Item Description

0S Mac OS X 10.4.11 or higher or 10.5.1 or
higher @

CPU Intel Core 2 Duo Processor 2.0 GHz or higher
(Intel Core 2 Duo Processor 2.4 GHz or higher
recommended) ?)

Memory |1 GB or more (2 GB or more recommended)

Introduction / Overview

SO %8 Jo4

47



SO OB\ 104

48

a) Mac OS is a trademark of Apple Inc., registered in the U.S. and other
countries.

b) Intel is a registered trademark of Intel Corporation in the United States and
other countries. Core is a trademark of Intel Corporation in the United
States and other countries.

All product names and brand names are registered
trademarks or trademarks of their respective owners.

XDCAM devices supported by the
application

This application supports the following XDCAM devices:

Series hame Model name

XDCAM HD422 (Version 1.2 or higher) | PDW-700

PDW-740

PDW-HD1500

XDCAM HD (Version 1.92 or higher) PDW-F355L

PDW-F335L

PDW-F335K

PDW-F75

XDCAM HD Drive PDW-U1

Installing the Application

Installing the Application

If the MainConcept plug-in software is installed
Update the plug-in software to the latest version (see page
84).

You can use the extended export function of the XDCAM
EX Clip Browsing Software Version 2.5.

If Version 1.0x is installed

Uninstall Version 1.0x (1.00 or 1.01) (see page 49) before
you start the installer.

Installing from the CD-ROM

1 Insertthe supplied CD-ROM into the CD-ROM drive
of your computer.

The disc icon appears on your desktop.

2 Double click the disc icon.
The contents of the CD-ROM appear.

3 Double click index.htm.

The cover page appears in your browser.

4 Select and click [MAC OS X] from the XDCAM EX
Clip Browsing Software Installer.

Finder starts and ClipBrowser.dmg appears.

5 Double click ClipBrowser.dmg.

Finder starts and ClipBrowser.pkg appears.

Q

6 Double click ClipBrowser.pkg.

The installation screen appears.



Welcome to the ClipBrowser Installer

You will be guided through the steps necessary to
install this software.

® Installatio]

Click the [Continue] button.
A license agreement screen appears.

Click the [Continue] button.

The following message appears.

To continue installing the software you must agree to the terms
of the software license agreement.

Click Agree to continue or click Disagree to cancel the installation
and quit the [nstaller.

Cosmee D) (g )

9 Click the [Agree] button.

A screen appears in which you can select the
installation destination.

1 OClick the installation destination volume.

Select a Destination

Select the volume where you want to install the
ClipBrowser software.

—
Macintosh HD
57.0 GB available
74.2 GB total

Installing this software requires no additional space.

| You have chosen to install this software on the volume
“Macintosh HD".

1 1 Click the [Continue] button.

The following screen appears.

Standard Install on “Macintosh HD"

Click Install to perform a standard installation of
this software on the volume "Macintosh HD",

Change Install Location. .

1 2 Click the [Install] button.

An authentication screen appears.

ﬂ Installer requires that you type your

. password.

Name:

Password: I| I

b Details

® (amee) G569

1 3Enter your name and password, and then click the
[OK] button.

The following screen appears when the installation
finishes.

Install Succeeded

The software was successfully installed.

1 4Click the [Close] button to close the dialog.

To uninstall the application

Move the installation destination folder of the application
(default: /Applications/XDCAM EX Clip Browser) to the
Trash.

Uninstalling the application also uninstalls the
MainConcept plug-in software at the same time.

Installing the Application 49
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Launching and Exiting
the Application

See “Installing the Application” (page 48) for more
information about how to install the application.
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Launching the application

Use Finder to open the XDCAM EX Clip Browser folder
in the Applications folder, and double click XDCAM EX
Clip Browser.

The application starts, and the operating windows (see
page 51) appear.

It is not possible to launch more than one instance of this
application at one time.

Exiting the application

Select [Quit XDCAM EX Clip Browser] from the
[XDCAM EX Clip Browser] menu.

Do not power off the computer while a file operation is still
underway. Files may be corrupted. Wait until the operating
finishes, or cancel the operation, before powering off.

Launching and Exiting the Application



Names and Functions of Parts

Operating window configuration

The following figure shows the default configuration of
the operating windows.

Menu bar

# XDCAM EX Clin Browser _ File Fdit View Preview Windaow

8ee8
Macintosh HD

(®{|-P |
B Macintosh HD.

7

Explorer - /

Used space  : 26.6GB
Free space

>
3 Applications
» [ Library

» [ System

> Users

Selected clins: 0 / Total duration: 00:08:00 / Total size 0.0 MB
Explorer - /
Macintosh HD

o Used space  : 26.6GB
(= WS Free space  :47.5GB
¥ Zi Macintosh HD
> !

» [ Applications
» [ Library

» [ System

»

Users

Selected clips: 0 / Total duration: 00:00:00 / Total size: 0.0 MB

47.5GB

Preview - No Clip

No Clip

General ' AV Format  Related Info

Index Picture Mark In Mark Out

Description

© Explorer windows

$ Preview window

© Explorer windows

You can have up to ten Explorer windows open at one
time. When you have more than one window open, you can
convert them into tabs on one window.

For details, see “Explorer window” (page 52).

©® Preview windows

You can have up to five Preview windows open at one
time. When you have more than one window open, you can

convert them into tabs on one window.

For details, see “Preview window” (page 55).

To customize the window configuration

To open another window

Select [New Explorer Window] or [New Preview
Window] from the [File] menu. A new Explorer or
Preview window opens.

To snap windows to each other
Drag one of the windows close to another window. The
windows snap together when they approach each other.

To tab windows

You can convert windows of the same type (Explorer or
Preview) into tabs in a single window.

To tab a window, drag it and drop it on another window.

Names and Functions of Parts
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Explorer -

ssssss

learaEy ‘k B e 2% pm
:
s

Used space  *26.6G8

Freespace 47508 12

Used space 26668

Freespace cazsca [

nnnnnnn

Selected clps 0 Toral duraton: 000000 / Toalsize: 0.0 W&

Tabbed windows

When one Preview window is already open, you can open

a new Preview tab by doing one of the following in an

Explorer window.

* Double click a media file in the List View pane.

* Select a media file in the List View pane, and then select
[Play] from the [Preview] menu.

If the selected media file is already loaded into its own
Preview window or a Preview tab, that window or tab is
activated.

To convert a tabbed window back into a separate
window

Drag the tab of the window that you want to separate away
from the other window.

Names and Functions of Parts

Used space 26,668
(SR | Freespace 47568 [

Selecteddips: 0 Total diraton: 000000/ Toal size- L0 NG,

¥

Explorer - Users/Blj/Downloads/Sample

Seected Cips0  Totl diration: C000,00 | Totasze; 0.0 |

Other window operations

* Drag the window title bar to move a window.

* Resize a window by dragging on any window border.

* Maximize a window or return it to its original size by
each clicking the + (zoom) button in the upper left
corner.

¢ Close a window you do not need by clicking the x (close)
button in the upper left corner.

The application remembers your most recent configuration
and recreates it the next time it starts.

Keyboard shortcuts for selecting tabs
You can use keyboard shortcuts to select tabs.
To select the previous or next tab from the

keyboard
Press Shift + Command + { or Shift + Command + }.

Explorer window

Explorer windows are where you operate on clips (files)
and folders, and where you check clip metadata. You can
operate on XDCAM EX/XDCAM HD format folders and
media.



Q Tab

ede

@ Toolbar

Explorer [ /Users /Bij/D ample

© View buttons

)

@ Capacity —

@ Path

Sample

Used space

IR Gloplr[aaou] ¥ ][] 7@ -:”Freespa(e

£ 26.6G8|

ece| 3|

v
3"
» [7 Applications
» [ Library
» [7 System
v [ J Users
v @By
(_. >
» | 7 Documey|
¥ | Downloa
» | g Materi
¥ | g Sampl
» | Test

| Macintosh HD |4

i

DUR 00:00.08:06" | DUR 00:00.23:18"
2007/01/03 22:15 | 2007/01/03 22:20 2007/01/03 22:34
709_0019_01

Desktop|! |~

¥ | Library -

709_0009_01 709_0015_01

DUR 00:00.10:02
200770103 22:42

709_0024_01

DUR 00:00:04:29

:0 |/ Total size: 52.2 MB ]

O Tree View
pane

[selected ciips: 1/ Total duration: 00-00

Folder
type

Information about
selected clips

List View pane

© Tab

The tab displays the name of the media or folder that is
selected in the Tree View pane.
When two or more Explorer windows are open, you can
drag and drop the tab on another window to convert this
window into a tab on the other window (see page 51).

® Toolbar

Contains tool buttons for operations on clips and folders.

Tool buttons Function Reference
lcon Name
Cut Cut the selected Page 61
.
= Copy Copy the selected Page 59
clp
Paste Pastes a clip that Page 59
has been cut or Page 61
copied. This can be
used to move a clip
to another media or
folder.
@ Delete Delete the selected | Page 62
clip or folder. Page 70

© Path

This is the full path to the media or folder that is selected

in the Tree View pane.

O Capacity

Displays the used capacity and remaining capacity of the

media selected in the Tree View pane.

© View buttons
Selects the List View pane view mode.

Buttons Function
Icon Name
== Thumbnails | Puts The List View Pane Into
1] Thumbnails View Mode.
=1 | Details Puts The List View Pane Into
— Details View Mode.

@ Tree View pane

Displays a tree of media and folders contained in drives.

Tool buttons Function Reference The following icons represent the type of the media or
Icon Name folder.
= New Folder |Creates a new Page 69 Icon Type of media or folder
= folder in the - -
currently selected = Hard disk drive
media or folder. s
Find Opens the Find Page 68 CD, DVD or Blu-ray Disc drive
dialog. 1
Up Moves up to the - XDCAM drive (normal)
next higher folder. g
Split Folder %)lzgf :;T;()Sg;p”t Page 71 XDCAM drive (UserData)
Copy All Copies all of the Page 60 .
clips in the selected | SxS memory card drive
nme?:,“%l%grogﬁirsto a Mass storage device (removable drive)
application creates — |connected by USB
Lhuionrﬁ\gtif:akljlsr {3- & Mounted network drive

Names and Functions of Parts
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Folder with EX attributes
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The Tree View pane supports the same kinds of operations
as the tree panel of Finder.

When you select a media item, a message may appear
saying that salvage is required, and that you should salvage
the media on the device that recorded it. This message
appears when the data is defective, typically because the
XDCAM EX device was powered off or the media was
ejected too soon during recording. If this message appears,
you should reinsert the media into the XDCAM EX device
and attempt to salvage it as soon as possible. The data may
become unrecoverable if you continue to work with it
without salvaging it.

Media

In this manual, “media” refers to the following media
types.
* SxS memory cards

* USB memory

* Internal hard disks

» Externally connected hard disks

* CD-R discs

* DVD-R discs

* Blu-ray discs

¢ Professional Discs (XDCAM drives)

© Folder type

Displays the type of the folder being selected in the Tree
View pane.

EX: Folder with EX attributes

MXF: Folder with MXF attributes

@O Information about selected clips

Displays information about the clips that are selected in the
List View pane (number of selected clips, total clip length,
and total size).

The total clip length is an approximate value, so take it as
an approximate guide.

© List View pane

Displays the clips in the media or folder that is selected in
the Tree View pane. You can select either of the following
view modes.

Names and Functions of Parts

Thumbnail View: This view displays the index picture of
each clip (or a thumbnail of the first frame, when no
index picture is set). It also displays the name of the
clip and the date and time when the clip was shot.

Details View: This view displays an icon indicating the
type and current state of the clip, the name of the clip,
and its properties.

To switch the clip view mode

Do one of the following.

¢ Select [Thumbnails] or [Details] from the [View] menu.

¢ Click the Thumbnails or Details button in the Explorer
window.

A mark for the clip status is displayed on the thumbnail or
icon in either of the view modes.

View mode |Icon |Description
Details view Normal MP4 file
=
MP4 file with OK status (as set on the
3 | XDCAM EX device)

1 | An MP4 file in which some of the
video cannot be displayed.

However, other parts of the video can
be previewed, and the properties of
the MP4 file can be edited like the
properties of normal MP4 files.

Abnormal MP4 file (without data,
cannot be decoded, etc.)

Normal MXF file

MXEF file with OK status (as set on
the XDCAM device) @

# | An MXF file in which some of the
video cannot be displayed.

However, other parts of the video can
be previewed, and the properties of
the MXF file can be edited like the
properties of normal MXF files.

Abnormal MXF file (without data,
cannot be decoded, etc.)




View mode | Thumbnail display | Description
example

Thumbnails Normal clip

view

Clip with OK status
(as set on the

XDCAM EX device) @

Part of a clip that
spans several media
discs or memory

devices. P)

A clip in which some
of the video cannot be
displayed. However,
other parts of the
video can be
previewed, and the
properties of the clip
can be edited like the
properties of normal
clips.

A clip that cannot be
loaded. The clip
cannot be previewed,
and its properties

cannot be edited. ¢ 9

a) Clips with OK status can be moved or deleted by this application.

b) XDCAM EX devices automatically save video that exceeds 4 GB in size
as multiple clips. These clips are parts of the complete recording and can
be saved on multiple media. Not all of the original recorded video is played
back when a split clip is played back.

c¢) The file may be corrupt, file links may be broken or changed, required files
may be missing, or thumbnail creation may have failed.

d) A clip that cannot be played or displayed properly by this application.
Another application is using the clip file.

To sort the View list
Select one of the following items under [Sort By] in the
[View] menu.

* Clip Name

* Size

e Duration

* Status

e Creation Date

* Last Update

* Recording Mode

* Media Spanning

To select the items to display in Details View
Open the dialog shown below by selecting [Customize
Columns...] from the [View] menu, and then proceed as
follows.

Customize Columns

Please select items to be displayed.

| V' Clip Name 4 f oK 3y
| ™ size ==
M Duration ( Cancel )
| Fj Status
E Creation Date Ir—-.up )
| E Last Update ) s —
™ Rec Mode " Down )
] Creator —_—
["] Description
| M Video Port { Show All )

M Video Codec
| 7] Capture fps
7] Recfps
| M Format fps
LM_Racolition. il

( Hice All }

[ Reset to Default

To select an item to display: Check the check box. You
can click the [Show All] button to check all of the
check boxes.

To select an item to hide: Clear the check box. You can
click the [Hide All] button to clear all of the check
boxes except “Clip Name”.

To change the display order: Click an item to highlight
it, and click the [Up] or [Down] button.

To return to the default settings: Click the [Reset to
Default] button.

To confirm the changes: Click the [OK] button.

To cancel the changes: Click the [Cancel] button.

Preview window

Preview windows are where you preview clips and check
clip information.

Notes about the Preview window

Playback in this window is preview playback. Note the

following points.

* Depending on the performance of your computer and the
processing load, dropped frames may occur, timecode
may differ from the actual values, the clip may not be
played smoothly, and some time may be required before
the screen is updated.

* When the playback clip is defective, video breakup may
occur and the playback may freeze.

* Not all of the original recorded video is played back
when a split clip is played back.

* It may not be possible to play clips created on devices
other than XDCAM EX devices.

* Improper playback may occur if the screen settings of
your computer are changed during playback. If this
occurs, restart the application.

Names and Functions of Parts
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© Tab
@ Viewer
‘ © Clip name
enle T ym!m

13:10:33:22 pur 00:00:04:29

4
i @ir@ @ﬂﬂ f\ f\ f“)..;ﬂ

l‘
(

Mark Out

Clip Name 709.0019_01

Creation Date  2007/01/03 22:34:09

LastUpdate  2008/04/16 12:24:50
310:36:26 Duratien

00:00:04:29

Index Picture

Mark In
+ 1310:31:27*

| + 1303127 ] + 13:10:3626
saws | OK 2

Te 1 [709_0019_01
Title 2

Creator
Description

$ Clip properties section
O Splitter

Viewer

© Screen
@ Clip type
T Number of essence marks

O Timecode

13:10:33:22 pur 00:00:04:29

O Tab

Displays the clip name.

When two or more Preview windows are open, you can
drag and drop the tab on another window to convert this
window into a tab on the other window (see page 51).

©® Viewer
Previews clips (see next section).

e Clip name
Displays the clip name of the selected tab.

(4] Splitter
You can drag the splitter up and down to change the

relative sizes of the viewer and the clip properties section.

@ Clip properties section
Allows you to check clip properties (see page 58).

Names and Functions of Parts

CIO) @@@ B@® & ®E W@
é Command buttons
Playline
Position bar
© Screen

Displays the playback video.

You can double click the screen or select [Full Screen]
from the [View] menu to enlarge the size to full screen
size.

To return to the original size, double click the screen again
or press the Esc key.

@ Clip type

Displays the type of the clip being viewed on the viewer.

XDCAM EX: XDCAM EX clip (MP4 file)

XDCAM HD/HD422: MPEG HD file created from
XDCAM HD or XDCAM HD422 clip (MXF file)

XDCAM HD Proxy: Proxy file created from XDCAM
HD or XDCAM HD422 clip (MXF file)

© Number of essence marks

Displays the number of the essence marks set in the clip (in
the format of: actually set number/maximum allowable
number).

O Timecode

Displays the timecode of the current position (playline
position), and the duration of the section between In and
Out points in the clip. A counter value is displayed when
no timecode is recorded in the clip.

For NTSC clips, a period (.) between the minutes and
seconds of the current position indicates drop-frame, and a
colon (:) indicates non-drop-frame.

It is possible to jump to a specified position by clicking the
current position timecode, entering a numeric value, and
pressing the Return key. (This operation is ignored when
invalid timecode is entered.)



You can change the timecode display format. For details,

Icon Button Keyboard | Function
see “User settings” (page 74). name operation
. Play Into | Shift + Plays the section from
© Position bar ,’f;\\, Out Space the In point to the Out
Displays the time scale of the clip. N point. (During play, the
The following marks are shown on the position bar to button icon lights
provide information about the clip. green.) Stops play if
clicked during play.
Mark Meaning /= [Mark Out a) |0 Sets an Out point at the
In point ( ' | current position. Can be
P Ay done during play (play
continues).
- Play Space Plays the clip. (During
Out point [ ) play, the button icon
Ay lights green.) Stops play
if clicked during play.
Essence mark = Add E Adds an essence mark
\ [ | ) Essence at the current position. ©)
U I Mark @ Can be done during play
lay continues).
Timecode break point (discontinuous ,(.ﬁ’ov\’,'e\,er, an es)sence
timecode) mark cannot be set at a
position where one
already exists.
O Playline N Delete Shift + E Deletes the essence
Displays the current position on the time scale. , | | Essence mark at the current
You can drag the playline or click anywhere on the S I Mark @ position. Can be done
position bar to move to a desired position. Scrubbing gg:{:ﬁu‘:g (play
(repeatedly dragging to the left and right) is also supported. i
N SetIndex |P Sets the current frame
@ Command buttons { < | | Picture as the index picture of
. . . . o the clip. Can be done
These butFons perform various clip preview operations. — duringpplay (play stops).
The functions of these buttons can also be accessed from - -
the kevboard N Set Audio |- Opens the Set Audio
¢ keyboard. ( |‘ | |Channels Channels dialog.
lcon |Button Keyboard |Function —
name operation Capture - Saves the frame at the
N Jump to Home Jumps to the clip start | a ) Still Image current position as a
[ 4= |Start point (first frame). p— bitmap file. This
command opens a
— dialog where you can
7, [ ump to End Jumps to the clip end specify the file name
[ 'H | |End point (last frame). and save destination.
However, still images
i cannot be created from
N Clear Mark | Shift + X Clears In and Out point a clip on XDCAM disk.
[ .GE} | [In/Out @ settings. Can be done
during play (play a) You cannot use these buttons to apply editing operations on clips existing
— continues). on the XDCAM drive. These buttons cannot add or delete edit points (In/
Out points) or essence marks in those clips.
N Jumptoin |1 Jumps to the In point. b) The maximum number of essence marks that you can set in a single clip is
f i# \ point as follows, depending on the clip format.
XDCAM EX clip: 126
"_" XDCAM HD clip (less than 126 seconds): the number of seconds + 1 (for
Jump to ! Jumps to the Out point. example, 46 marks for a 45-second clip)
| "DP | | Out point XDCAM HD clip (126 seconds or more): 126
Mark In® |I Sets an In point at the
,ﬁ| current position. Can be
N A done during play (play
continues).
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Clip properties section

General tab

General " A/V Farmat ' Related [nfo

Index Picture Mark Out

= Last U
+ 13:10:32:04 + 13:10:31:27" | # 13:10:36:26 T Let

staws | OK 2
709_0019_01

705_0019_01
Jan 3, 2007 10:34 PM
May 14, 2008 12:27 PM
00:00:04:29

Title 1

Title 2

Creatar

Descriptian

This tab displays general information about the clip.

Index Picture: Displays the index picture of the clip, or a
thumbnail of the first frame if no index picture has been
set.

Mark In: Displays a thumbnail of the In point, or a
thumbnail of the first frame if no In point has been set.
Mark Out: Displays a thumbnail of the Out point, or a

thumbnail of the last frame if no Out point has been set.

Clip Name

Creation Date (date and time of creation)

Last Update (date and time of most recent update)
Duration (clip length)

Status: Displays the clip status. You can select the status
from among OK, NG, KEEP, and None.

Title 1: Allows you to assign a title up to 63 ASCII bytes
in length.

Title 2: Allows you to assign a subtitle up to 127 bytes in
length.

Creator: Allows you to enter the name of the person who
shot the clip, up to 127 bytes in length.

Description: Allows you to enter a description of the
scene depicted in the clip, up to 2047 bytes in length.

To save changes to the Status, Title 1, Title 2, Creator, and
Description fields, you must click the Update button. The
changes are discarded if you close the window or tab
without clicking the Update button.

A/V Format tab

General * A/V Format . Related Info

Video Format

Port DIRECT

C MPEG2 HDLong 25Mbps

T Capture 59.941 Rec 59.94 Format 59.94i
Layout 1440 x 1080 16:9

PullDown Type 11 Frame Phase 00

el 1 Port
el 2 Port

ANALOG Codec
ANALOG Codec

16bitLPCM
16bit LFCM

Names and Functions of Parts

This tab displays information about the recording format
of the clip.

* Video Format

* Audio Format

Related Info tab

General " A/V Format ' Related Info

Model Sony
Apollo

r 012345

Lens Model

Rec Mode Type normal Cache Rec No

Media Spanning No

umMiD 060A2E340101010501010D43130000002602BD30034 1050608000101
Key Frame 13

User Bit

Proxy AV Data
Edit List

Hard- & Software

0000B080A0F7AEBD

This tab displays information related to clip recording
conditions.

* Model

* Lens Model

* Recording Mode
* Media Spanning
« UMID

* Key Frame

* User Bit

* Proxy AV Data
 Edit List

* Hard- & Software



Clip Operations

Clip operation precautions

* Always observe the following precautions during
processing of clip operations.
- Do not power off the computer or media drive before
the operation completes.
- Do not use Finder or another file management tool to
delete folders that contain the clips being processed.

- Do not eject the media before the operation completes.

* It may be possible to copy and move clips to media with
this application even when the display on an XDCAM
EX device indicates that the media is full. However, it
will not be possible to play back or delete those clips
when the media is inserted into the XDCAM EX device
again (a message will appear saying that the media must
be salvaged).

* For the folders created on a hard disk or other media by
copying from XDCAM drive with Finder or other folder
management tool, editing operations such as adding and
deleting of clips cannot be performed.

* When writing clips to XDCAM drive, it is necessary
beforehand to set the NAMING FORM option in the
XDCAM HD device menu to “free (no format).” If the
option is set to “C**** (standard format),” any clip with
an arbitrary name other than C**** cannot be written to
XDCAM drive.

* Writing a 50p or 60p frame rate clip to XDCAM drive
moves the essence marks and Out points at the odd
frames to the previous or next even frames. For example,
the essence mark at the 15th frame moves to the 14th,
while the Out point at the 19th frame moves to the 20th.
However, the Out point will be deleted if an essence
mark already set at the move destination frame.

For details about the menu operations of the XDCAM HD
device, refer to the Operating Instructions or Operation
Manual supplied with the XDCAM HD device.

Copying clips

You can duplicate clips on your media or computer, and
copy clips between media and the computer.

When copying MXF clips to XDCAM drive or a folder
with MXF attributes, it is not possible to copy the clip of a
different recording format from that of the clips in the
destination.

Grouping split clips by gathering them into one
place

XDCAM EX devices automatically save video that
exceeds 4 GB in size as multiple clips. If you collect these
clips into one media or folder, they are automatically
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate
media” (page 62) for more information.

To copy selected clips

1 Selecta clip to copy in the List View pane of an
Explorer window.

* Abnormal clips can be selected, but they are not
copied.

* The folder that contains the selected clips cannot be
specified as the copy destination.

If you want to copy the clips to a new folder
Create a new folder in the copy destination media or
folder.

See “Creating folders” (page 69) for more
information about how to create folders.

2 Do one of the following.

* Drag the clips selected in step 1 and drop them in the
List View pane of another window, or on a copy
destination media or folder in the Tree View pane of
the same window or another window.

* Click the Copy button. Then click the List View
pane of another window, or a copy destination media
or folder in the Tree View pane of the same window
or another window, and click the Paste button of that
window.

* Select [Copy] from the [Edit] menu. Then click the
List View pane of another window, or a copy
destination media or folder in the Tree View pane of
the same window or another window, and select
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the
copy.

ﬁ The clip will be copied. OK?
=l

C No ) Gowesa)

3 Click the [Yes] button to execute the copy, or the [No]

button to cancel it.

Clip Operations
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A dialog illustrating the progress of the copying opens
when the copying starts.

Once it has been completed, you cannot undo the copy
operation.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail

Copy operations may fail for the following reasons. In

these cases, an error message appears and the copy is

not executed.

* There is not enough free capacity at the copy
destination.

* A clip with the same name as one of the selected
clips already exists at the copy destination. Even if
the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* You do not have delete/write privileges to the
destination media or folders.

* The destination media or folder is write protected.

If you copy an XDCAM EX file to a copy
destination with MXF attributes

Copying an XDCAM EX file (MP4 file) to XDCAM drive
or an MXF folder automatically converts the file to the
XDCAM HD format (MXF file). This makes EX material
available on your XDCAM HD device more easily than
the export function (see page 64).

Copied files have the same recording format as that of the
existing files in the destination. D However, the bit rates are
determined as specified in [Bit Rate] under [MP4 to MXF
conversion by copy] in the Conversion tab of the
Preferences dialog (see page 75).

1) If no file exists in the destination, the bit rate is determined as specified in
[Format Settings: when there’s no clip in the folder] under [MP4 to MXF
conversion by copy] in the Conversion tab of the Preferences dialog.

Supplement

When the [Convert in MXF for copying EX to a normal
folder] check box in the General tab of the Preferences
dialog (see page 74) is checked, even the files which are to
be copied to a normal folder are converted to the MXF
format. Since the clip management folders for the
XDCAM HD device (see page 73) are automatically
created, the files converted in this application can be
viewed. (The files which were output to a normal folder by
the export function cannot be viewed in this application.)

* It is not possible to convert the XDCAM HD files to the
XDCAM EX format.

Clip Operations

* File conversion is not possible depending on the
combination of source format and target format.

* File conversion may degrade the image quality.

* This copy operation takes longer to complete since it

requires format conversion.

XDCAM EX to XDCAM HD format conversion

produces only MPEG HD files as MXF files. It does not

produce Proxy files.

To copy all the clips in media or folders

You can copy all of the clips in a folder or a media disc or
card in a single operation. This is a convenient way to
import all the clips in an SxS memory card to the hard disk
of your computer.

1 In the Tree View pane of an Explorer window, select
the media or folder that contains the clips you want to

copy.
2 Do one of the following.

¢ Click the Copy All button.
 Select [Copy All] from the [Edit] menu.

A message appears asking if you want to execute the
copy. Check the destination folder.

You can change the copy destination folder. See “User
settings” (page 74) for more information.

ﬂ All clips will be copied ta [ /Users/Bll/Sany/ClipBrowser/20080414171203 | . OK?
i | —
(N0 ) EowEse)

3 Click the [Yes] button to execute the copy, or the [No]
button to cancel it.

A dialog illustrating the progress of the copying opens
when the copying starts.

To cancel the copy operation
Click the [Cancel] button in the progress dialog.

Reasons why a copy operation may fail

Copy operations may fail for the following reasons. In

these cases, an error message appears and the copy is

not executed.

* There is not enough free capacity at the copy
destination.

* A clip with the same name as one of the selected
clips already exists at the copy destination. Even if
the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* You do not have delete/write privileges to the
destination media or folders.

 The destination media or folder is write protected.



Copy error check option

For greater copy reliability, you can enable the CRC
(cyclic redundancy check) error check option. However,
copy operations take longer to complete when this option
is enabled.

See “User settings” (page 74) for more information about
this option.

Moving clips

You can move clips on your media or computer, and move
clips between media and the computer.

* You cannot operate clips in other than XDCAM EX
format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* Clips with OK status can be moved by this application.

Grouping split clips by gathering them into one
place

XDCAM EX devices automatically save video that
exceeds 4 GB in size as multiple clips. If you collect these
clips into one media or folder, they are automatically
grouped so that you can handle them as a single clip.

See “Grouping clips that have been split across separate
media” (page 62) for more information.

Move modes

You can specify whether to give priority to processing

speed or to data protection when moving clips.

* Processing speed: Normal move processing, without
creating a duplicate of the clip.

* Data protection: A duplicate of the clip is created before
the original clip is deleted.

See “User settings” (page 74) for more information about
the settings.

1 Selecta clip to move in the List View pane of an
Explorer window.

* Abnormal clips can be selected, but they cannot be
moved.

* The folder that contains the selected clips cannot be
specified as the move destination.

If you want to move the clips to a new folder
Create a new folder in the move destination media or
folder.

See “Creating folders” (page 69) for more
information about how to create folders.

Do one of the following.

 Drag the clips selected in step 1, and while holding
down the Shift key, drop them in the List View pane
of another window, or on a copy destination media
or folder in the Tree View pane of the same window
or another window.

¢ Click the Cut button. Then click the List View pane
of another window, or a copy destination media or
folder in the Tree View pane of the same window or
another window, and click the Paste button of that
window.

¢ Select [Cut] from the [Edit] menu. Then click the
List View pane of another window, or a copy
destination media or folder in the Tree View pane of
the same window or another window, and select
[Paste] from the [Edit] menu.

A message appears asking if you want to execute the
move.

ﬁ The clip will be moved. OK?
|3

C nNo ) (okes—)

Click the [ Yes] button to execute the move, or the [No]
button to cancel it.

A dialog illustrating the progress of the move opens
when the move starts.

* Once it has been completed, you cannot undo the
move operation.

* Do not exit this application during the move. Doing
so can break the links between clips and their
metadata. The link information for split clips can be
lost, causing them to become abnormal clips. If the
selected clips are important, we recommend that you
set the move mode to data protection mode (see page
61).

To cancel the move operation
Click the [Cancel] button in the progress dialog.

Reasons why a move operation may fail

Move operations may fail for the following reasons. In

these cases, an error message appears and the move is

not executed.

* There is not enough free capacity at the move
destination.

* A clip with the same name as one of the selected
clips already exists at the move destination. Even if

Clip Operations 61
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the clip names are different, clips are recognized as
the same clip if they share the same ID (UMID).

* Youdo not have delete/write privileges to the source
or destination media or folder.

* The source or destination media or folder is write
protected.

Deleting clips

* Clips with OK status can be deleted by this application.
* Deleting a clip linked to edit lists deletes all the edit lists
linked to the clip.

1 In the List View pane of an Explorer window, select a
clip to delete.

2 Do one of the following.

* Press the Delete key with the Command key held
down.

* Click the Delete button.

¢ Select [Delete] from the [Edit] menu.

A message appears asking if you are sure you want to
delete the clips.

ﬁ The clip will be deleted. OK?
L1

C No ) keSS

3 Click the [Yes] button to execute the deletion, or the
[No] button to cancel it.

It is not possible to undo the deletion once it has been
completed.

Reasons why a delete operation may fail

Deletion operations may fail for the following reasons.

In these cases, an error message appears and the

deletion is not executed.

* You do not have delete/write privileges to media or
folder where the clips are stored.

* The media or folder where the clips are stored is
write protected.

Grouping clips that have been split
across separate media

When you have split clips that have been saved on separate
media as a result of an extended recording session, you can

Clip Operations

group those clips by collecting them in a single location.
Grouped clips can be handled as a single clip. You can
collect split clips by copying them, by moving them, or by
combining split folders.

See “Copying clips” (page 59), “Moving clips” (page 61),
and “Combining folders” (page 71) for more information
about the operations.

* You cannot operate clips in other than XDCAM EX
format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* Split clips which are not continuous along the time axis
are not grouped.

* Abnormal clips are not grouped.

* Clips with altered UMIDs are not grouped. Grouping is
performed on the basis of the UMIDs of split clips, and
not on the basis of their file names.

Creating clips by specifying ranges

You can create a new clip by setting In and Out points in
an existing clip. The new clip can be handled in the same
way as the original clip. This is a convenient way to create
clips during online editing.

Y ou cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 Previewa clip in a Preview window (see page 66),
click the Mark In button at the position you want to use
as the first frame, and click the Mark Out button at the
position you want to use as the last frame.

In and Out points are set in the clip.

Supplement

You can also set the Out point by specifying the In
point and duration.

Duration can be specified by clicking the timecode
display of the duration, entering a numeric value, and
pressing the Return key.

In and Out points cannot be set at the same frame.
When you try to set an Out (or In) point at a frame
where an In (or Out) point has been set, the Out point
is automatically set at the next frame after the In point.



2 Play the section specified in step 1, and adjust the In
point and Out point positions as required.

3 In the List View pane of an Explorer window, find the
clip where you set the In and Out points, and click the
clip to select it.

To create several clips in one batch operation
You can create several clips in one operation.

Carry out steps 1 and 2 in several clips stored in the
same folder or on the same media, and then select
those clips here.

4 From the [File] menu, select [New clip using In/Out
section].

A confirmation message appears asking if you want to
create the clips.

ﬁ A new clip will be created: Is it OK?
|

C No ) GowEs)

If the In and Out points are not set

The following message appears. If you choose to
continue, the effect is the same as copying the
complete original clip.

Mark In and Mark Out are set at the beginning and the end of the dlip respectively.
The whole clip will be copied. s it OK?
L3

(No ) s

5 Click the [Yes] button to create a new clip, or the [No]
button to cancel the operation.

A progress dialog opens when creation of the clip
starts.

To cancel creation of the clip
Click the [Cancel] button in the progress dialog.

Reasons why a new clip operation may fail

Creation of a new clip may fail for the following

reasons. In these cases, an error message appears and

the clip is not created.

* There is not enough free capacity at the clip creation
destination.

* You do not have delete/write privileges to the
destination media or folders.

Importing clips

You can import XDCAM EX format compatible MP4 files
and register them as clips that can be handled by XDCAM
EX devices.

You cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1

In the Tree View pane of an Explorer window, select
the media or folder that contains the MP4 files to be
imported.

Do one of the following.

* Select [Import...] from the [File] menu.

* Click the media or folder while holding down the
Control key, and select [Import...] from the context
menu.

The Import dialog opens.

QOO Open

[« 7»] [s2]=]m] (3 104_0008_01 Bl Qsea

& cer » o] 104_0008_01 GOl C: 1040008 01.MP4
CUEUP.XML (& 603_0001_01 L f _OLSMI
MEDIAPRO.X [ 7093201 01 08_01101 7P
Sca. 4 RO [ P20070724111553_01
» SHARED
¥ PLACES
A Desktop
@ ay
/A Applications
"l Documents
¥ MEDIA
B Movies

Select MP4 files to import.

Click the [Start] button to start the import, or the
[Cancel] button to cancel it.

A dialog illustrating the progress of the import
operation opens when the import starts.

To cancel the import operation
Click the [Cancel] button in the progress dialog.

Reasons why an import operation may fail

File import operations may fail for the following

reasons. In these cases, an error message appears and

the files are not imported.

* You do not have delete/write privileges for the
import destination media or folder.

* The import destination media or folder is write
protected.

* The properties of imported clips are set
automatically.

* The format of imported clips is not fully compatible
with the XDCAM EX format. It may not be possible
to play imported clips on XDCAM EX devices and
with this application.

Clip Operations
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Exporting clips

You can export files created on XDCAM EX devices for
use in various other environments. (To export is to convert
files into other formats and output them.)

Future versions will support additional video formats. For
upgrade information, visit the website listed in the
“Features” section of the Operating Instructions for your
XDCAM EX device and on the cover page of the supplied
CD-ROM.

You cannot operate clips in other than the XDCAM EX
format (for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 In the List View pane of an Explorer window, select a
clip to export by clicking them.

2 Do one of the following.

* From the [File] menu, select [Export] and then select
the format that you want to convert to.

* Click the clip while holding down the Control key,
from the context menu, select [Export] and then
select the format that you want to convert to.

See “File conversion formats” (page 65) for more
information about the available conversion formats.

An export dialog opens for the selected format. (The
figure below shows the dialog that opens when you
choose [MXF for XDCAM HD422].)

(o Nal) MXF for XDCAM HD422

Export to

Folder: | /usars/Bl| f:
Free space :47.1G8
Type
XDCAM HD 422

Target of Export

@ Whole Clip O In/Out section

Clip Name Input File Outpu File Status
709_0009_01 EGy10322_01.MP4 E6y10322_01.mxf

1¢lip.

3 Change the following settings as required.

Export to: Specifies the export destination folder.
Enter a path beginning with a drive name in the
edit box. Or click the [...] button to open a browse
dialog where you can select a folder, and then
click the [OK] button.
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Make sure that the export destination media has
adequate free space before you execute the
export. An error occurs at the point where the free
space is used up.

Type: Click the [Details...] button to open the Codec
Detail dialog, set parameters as required, and then
click the [OK] button. This item does not appear
for some conversion formats.

ann Codec Detail

Type:  XDCAM HD422
Vide

Codec:  MPEG2(4:2:2) *l Width: 19205 Framerate
Profile: 1€ ~ Height 1080 |+ Bitrate:

Audia

Codec: |1 M *! Channel: acrf ~  Samplerate: 4 1z *| Bitrate:

When “1CH?” is selected in the [Channel] list box
of the [Audio] section, a mixed signal of the
channels 1 and 2 is output.

Target of Export: Select [In/Out section] if you want
to output the range between the In and Out points
in the current clip. This item does not appear for
some conversion formats.

To change the output file name

In the List View pane, do one of the following to make

the file name changeable.

* Click the file name.

¢ Click the highlighted part while holding down the
Control key to display the context menu and select
[Modify the output filename] from the context
menu.

Clip Name | Input-File | Dutput File

709 0009 01 EGy10322 01.MP4 EBy10322 01 !

Enter a new name, and press the Return key or click
anywhere other than the file name. Extension does not
need to be entered.

Click the [Execute] button to start the export.

A progress bar appears to show the progress of the
export. The progress also appears in the [Status]
column of the List View pane.

To cancel the export
Click the [Cancel] button.

If a file with the same name already exists at the
output destination
A dialog appears to ask how you want to proceed.



Read the explanation in the dialog and click one of the
buttons.

A file having the same name exists in the destination folder.
Do you continue?
71 Yes: The existing file will be overwritten.
No: The process will be canceled.
Skip: The file isn't overwritten but skipped.

-

C N )  skip ) € owEs )

* The optional MainConcept plug-in software must be
installed to use some conversion formats (see page 84).
If the plug-in is not installed, a watermark appears in the
exported video, and audio is saved for the first 30
seconds only (the subsequent audio is muted).

* Depending on the specified parameters, image quality
may be degraded due to the image compensation
process.

* Converted files may not be exactly the same with native
files in the target format.

* Video metadata may not be inherited after format
conversion.

* Image quality may be degraded if format conversion
requires re-encoding.

* Image quality may be degraded and duration may vary if
files are converted to a format with a different bit rate,
resolution, or frame rate parameters.

» Before exporting, ensure that the export destination
media or folder is write enabled.

File conversion formats

File conversion formats can be selected with the Export
subcommands in the following table.

Export
subcommand

Extension
after
conversion

Description

MXF for XDCAM
DVCAM ®

mxf

Converts to an MXF format
that is compatible with
MXEF files recorded by
XDCAM DVCAM devices.

Raw DV

dv

Converts to RAW DV
format.This is for DV format
editing. Depending on the
editing environment, use
either this subcommand or
the [AVI DV] subcommand.

AVI DV

avi

Converts to AVI Type-2
format.This is for DV format
editing. Depending on the
editing environment, use
either this subcommand or
the [RAW DV]
subcommand.

Avid AAF

AAF/mxf

Converts to the following

two file formats.

AAF file: Use to load clips
into Avid editing
system. The extension
is AAF, and the output
destination is the
media or folder
specified in the Export
dialog (see page 64).
AAF files produced by
the conversion can be
registered in your Avid
editing system project
by dragging from
Finder to a bin in the
project.

MXF OPAtom file: The
extension is mxf, and
the output destination
is the media or folder
specified in the
Conversion tab of the
Preferences dialog
(see page 75).
Normally this is the
media folder of your
Avid editing system
project.

For details, refer to the

user’s manual of your

editing system.

Windows Media
File

wmyv

Converts to Windows
Media Player 9 compatible
format.

Export Extension |Description
subcommand | after
conversion

MXF for NLEs @ | mxf Converts to MXF file format
without changing the bit
rate, resolution or other
parameters. This is for non-
linear editors that support
MXF files only.

MXF for mxf Converts to an MXF format

XDCAM HD b): ©) that is compatible with
MXEF files recorded by
XDCAM HD devices.

MXF for mx(f Converts to an MXF format

XDCAM that is compatible with

HD422 b). d) MXF files recorded by
XDCAM HD422 devices.

MXF for XDCAM | mxf Converts to an MXF format

MPEG IMX © that is compatible with
MXEF files recorded by
XDCAM MPEG IMX
devices.

Sony PSP
(H.264/AVC) 9)

mp4

Converts to a format that
allows clips to be
previewed on the
PlayStation Portable (PSP)
game console from Sony
Computer Entertainment.
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Export Extension |Description
subcommand | after
conversion
Apple iPod mp4 Converts to a format that
(H.264/AVC) 9) allows clips to be
previewed on the iPod
portable media player from
Apple Inc.
Video hosting wmv Converts to a format
service optimized for Internet video
hosting services.
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a) When outputting the range between the In and Out points in the current
clip, the duration may be prolonged after conversion.

b) Clips of two seconds or less can be converted to MXF files, but they
cannot be written to export destination devices.

¢) 23.98p clips can only be converted to a format with the same frame rate
(23.98p).

d) 23.98p clips cannot be converted.

e) This application supports copying, deleting, and viewing properties of
XDCAM MPEG IMX or XDCAM DVCAM clips. It does not support
previewing and the other operations. Thumbnail creation fails.

f) Avid editing systems may refuse to import a clip that has already been
exported to the editing system.

g) Improper playback may occur if the converted file is viewed on a viewer
other than the specified devices.

Previewing clips

You can preview clips in the Preview window.
Several limitations apply to playback in the Preview
window.

For details, see “Notes about the Preview window” (page
55).

To load clips in the Preview window

Display the clip that you want to preview in the Clip View
pane of an Explorer window, and then do one of the
following.

* Double click the clip.

* Click the clip and then press the Return key.

* Drag and drop the clip on a Preview window (this
operation is disabled if multiple clips are selected).
Click the clip while holding down the Control key, and
select [Play] from the context menu.

Click the clip and then press the space key.

The clip is loaded into a Preview window (and, when the
fourth or fifth operation as stated above has been done, the
playback starts). The timecode of the current playback
position (or a counter value) appears in the upper part of
the screen, together with the duration of the section
between In and Out points in the clip.

To stop play
Click the play button.

Clip Operations

Smooth playback is not possible when previewing clips
saved to DVD-R or CD-R discs.

To control the preview

You can use the following methods to control playback in
the Preview window.
* Use the command buttons (see page 57) in the Viewer
window.
* Select an operation from the [Preview] menu.
* Drag the playline.
* Press the J, K, or L key.
J: Change the reverse playback speed. Each press selects
-1,-2, -4, -8, or —16 times normal speed.
K: Stop playback.
L: Change the forward playback speed. Each press
selects 1, 2, 4, 8, or 16 times normal speed.

No audio is output in playback at speeds greater than +4
times normal speed.

To select full-screen playback

Double click the screen, or select [Full Screen] from the
[View] menu.

To return to the original screen size, double click the
screen or press the Esc key.

To change the playback mode of MXF clips
Select “MPEG HD (high resolution)” or “Proxy (low
resolution)” in the Play tab of the Preferences dialog (see
page75).

Selecting “MPEG HD” makes it possible to preview high
definition images when the screen size is enlarged.

* You cannot change the playback mode when a clip is
being played.

* Clips without proxy AV data are played at high
resolution regardless of this setting.

* Clips on XDCAM drive are played at low resolution
regardless of this setting.

* High resolution data may not be played smoothly due to
its large file size.

To select the audio channels to monitor during
previews

In the Set Audio Channels dialog, check the L (left) or R
(right) check box to monitor that channel.

To open the Set Audio Channels dialog, do one of the
following.

¢ Select [Set Audio Channels...] from the [Preview] menu.
¢ Click the Set Audio Channels button.



M M 7 Set Audio Channels

-

CH1
CHz
CH2
CH4
CH5
CH6
CH?
CH8

[T
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To edit essence marks

Use the Edit Essence Marks dialog.

To open the Edit Essence Marks dialog, load a clip into a
Preview window, and activate the Preview window. Then
select [Edit] and then select [Edit Essence Marks...] from
the [Preview] menu.

Edit Essence Marks

i'l"\mecnde [ Comments
|13:10:33:12* _ShotMarkl

|13:10‘.34:2?' _ShotMarkl
13:10:35:27* _ShotMarkl

| o)
(" Cancel

Essence marks in clips on XDCAM drives cannot be
edited.

To edit a comment: Select an essence mark in the list and
click the [Edit] button. This opens the Edit Comments
dialog. Edit the comment in the dialog and click the
[OK] button. The maximum length of comments is 32
bytes. The edited comment appears in the Comment
field of the Edit Essence Marks dialog.

_Shothark]

Cancel OK

To delete an essence mark: Select an essence mark in the
list (you can select multiple essence marks by
selecting with the Shift key held down) and press the
[Delete] button.

To confirm changes: Click the [OK] button in the Edit
Essence Marks dialog.

To discard changes: Click the [Cancel] button in the Edit
Essence Marks dialog.

* The only essence marks that can be displayed on
XDCAM EX devices are “_ShotMark1” and
“_ShotMark2”.

* During playback on XDCAM EX devices, essence
marks set by this application are displayed next to the
frames where they were set.

Changing the index picture of a clip
You can change index pictures during clip previews.

1 Play a clip, and display the frame you want to use as
the index picture.

2 Select [Edit] and then select [Set Index Picture] from
the [Preview] menu, or click the Set Index Picture
button.

The currently displayed frame becomes the clip’s
index picture, and the Index Picture in the General tab
of the clip properties section changes to show it.

* If you are previewing a clip that is stored on
removable media, do not eject the media until the
operation finishes.

* Do not power the computer off until the operation
finishes.

* On XDCAM EX devices, a frame near the specified
frame may be displayed as the index picture, instead
of the specified frame itself.

Creating still images

1 Play a clip in a Preview window, and stop at the scene
you want to use as the still image.

2 Do one of the following.

* Press the Capture Still Image button.

 Select [Capture Still Image...] from the [File] menu.

A dialog opens in which you can specify the file name
and storage destination.

3 Specify the file name and storage destination and click

the [OK] button.

A bitmap still image is created from the frame selected
in step 2.

Clip Operations
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It is not possible to create still images from a clip on
XDCAM disk.

Searching for clips

You can search for a clip in either of the following ways,

depending on whether you know where the clip is located.

Folder search: When you know where the clip is located,
you can search a specified folder for clips with
specified properties.

Keyword search: When you know only the fact that the
clip is located on the computer on which this
application is installed, you can perform a keyword
search.

Always observe the following precautions during a search.

* Do not delete the target folder.
* Do not eject the target media.

1 Activate a Preview window and do one of the
following.

¢ Click the Find button.
¢ Select [Find] and then select [Find...] from the [Edit]
menu.

The Find dialog opens.
2 Specify search criteria.

Specified Folder tab

ene Find

Specified Folder . Keyword Searching

Target

/Users/Bl) ) (sar)
¥ Criteria

Items Keyword |

| Clip Name 13 709
[E2 )

" Case sensitive

| Narrow down search

@ Include all keywords
O Include any of the keyword
O Exclude keywords

Clip Name Size | Duration Status Folder Path

To search a different folder: Click the [...] button to
open a browse dialog, select the target folder, and
click the [OK] button.

To specify search criteria: Select at least one item
from the [Items] list, and enter the matching
condition in the text box for that item, or select the
condition from the list.

To specify the type of search: Click “Include all
keywords” (AND search), “Include any of the
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keywords” (OR search), or “Exclude keywords”
(NOT search).

To specify search options: As required, check “Case
sensitive” and “Narrow down search” (narrow
down the search within the results of the previous
search).

When [Clip Name] is selected from the [Items] list,
search is performed based on the [Clip Name] settings
in the Display tab of the Preferences dialog.

Keyword Searching tab

* Keyword search uses the Mac OS Spotlight which is
an indexed search system. The index is updated at
times when the computer is not being used for other
tasks. Therefore, even if clips exist on the hard disk
of the computer, they will not be found if they have
not yet been indexed.

* The drives of XDCAM HD devices are not searched.

8ne6 Find

Spacified Folder  Keyword Searching

Clip Name Size| Duration Status Folder Path

To specify the keywords to find: Enter the keywords
to find in the Keywords box. You can enter
multiple keywords. An AND search is performed
(partial match). Uppercase and lowercase are not
distinguished.

Click the Start button.

A list of search results appears in the Find dialog,
containing clips that match the conditions specified in
step 2.

To hide the search criteria in the Specified Folder
tab

Click the “~” button.

Click the “+” button when conditions are hidden to
show them again.

To sort the search results
Click the header of the column that you want to use as
the sort key.



With each click, the list is sorted in ascending or
descending order.

To display the search results in an Explorer

window

Select one of the search results and do one of the

following.

¢ From the [Edit] menu, select [Find] and then select
[Go to Explorer].

* Click the result while holding down the Control key,
and select [Go to Explorer] from the context menu.

To play the search results

Select one of the search results and do one of the

following.

* Select [Play] from the [Preview] menu.

* Click the result while holding down the Control key,
and select [Play] from the context menu.

Folder and Media
Operations

Folder and media precautions

Always observe the following precautions during

processing of folder and media operations.

* Do not power off the computer or media drive before the
operation completes.

* Do not eject the media before the operation completes.

Folders for XDCAM EX clips

XDCAM EX clips are stored together with a BPAV folder
(see page 73). (This folder does not appear in the Explorer
window, but it can be seen in Finder.)

Whenever you copy or move clips with this application,
the BPAV folder is copied or moved along with the clips.
You cannot work with clips separately from the BPAV
folder.

Simultaneous access to files may not be possible when you
attempt to access the same folder at the same time from
several computers over a network connection.

Folders for MXF clips

A folder for managing MXF clips must have three

subfolders: Clip, Edit, and Sub (see page 73). Clips cannot

be saved in the Clip subfolder unless they match the clips

existing in that subfolder in terms of the following

characteristics.

* Frame rate (NTSC/PAL/24p)

* Codec (MPEG IMX/DVCAM/HDA4:2:0/HD4:2:2)

» Resolution width (coincidence of resolution height not
required).

* Bit rate when the codec is MPEG IMX

These conditions are determined by the format of the clip
first saved in the Clip subfolder. When copying MXF
clips, it is necessary to check the source clips and the clips
existing in the copy destination folder to be sure that these
conditions are satisfied.

Creating folders

1 In the Tree View pane of an Explorer window, select
the media or folder where you want to create the
folder.

Folder and Media Operations
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2 Do one of the following.

¢ Click the New Folder button.

¢ From the [File] menu, select [Folder] and then select
[New Folder].

* Click the media or folder while holding down the
Control key, and select [New Folder] from the
context menu.

A new folder is created in the media or folder selected
in step 1.

Reasons why folder creation may fail

Folder creation operations may fail for the following

reasons. In these cases, an error message appears and

the folder is not created.

* You do not have write privileges for the selected
media or folder.

* The selected media or folder is write protected.

* Folders cannot be created when writing is not allowed by
the computer file system.

» New folders are created as normal folders. But when
even one clip is copied or moved to the new folder, the
folder is formatted as an XDCAM EX or XDCAM HD
work folder. (The required subfolders and metadata files
are created automatically.)

SO OB\ 104

To rename a folder

1 Select a folder and do one of the following.

¢ From the [File] menu, select [Folder] and then select
[Rename].

* Click the folder while holding down the Control key,
and select [Rename] from the context menu.

The folder name is selected, so that now you can edit
the name.

2 Enter anew name, and then press the Return key or
click somewhere outside the folder name.

* The name “BPAV” is reserved and cannot be
specified.

* Characters forbidden by the operating system
cannot be used in folder names.

* A folder name comprised of 200 or more characters
may not be recognized.
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To back up folders

1

2

3

In the Tree View pane of an Explorer window, select
the folder that you want to back up.

Do one of the following.

¢ Select [Show in Finder...] from the [File] menu.

¢ Click the folder while holding down the Control key,
and select [Show in Finder...] from the context
menu.

Finder starts.

Perform your backup operations in Finder by copying
the folder to other media or to another folder.

When a folder is too large to save to your backup
media

You can split the folder into smaller folders, and save them
on separate discs. Split folders can later be combined to
restore the original large folder.

See “Splitting folders” (page 71) and “Combining
folders” (page 71) for more information.

Deleting folders

1

2

In the Tree View pane of an Explorer window, select
the folder to delete.

Do one of the following.

* Press the Delete key with the Command key held
down.

¢ Click the Delete button.

¢ Select [Delete] from the [Edit] menu.

¢ Click the folder while holding down the Control key,
and select [Delete] from the context menu.

A message appears asking if you want to execute the
deletion.

[ Sample | will be deleted.
oK?
| =

C no ) € oves )

Click the [Yes] button to execute the deletion, or the
[No] button to cancel it.



Reasons why a folder deletion may fail

Folder deletion operations may fail for the following

reasons. In these cases, an error message appears and

folder is not deleted.

* You do not have delete/write privileges for the
selected folder.

* The selected folder is write protected.

* Clips or other folders exist beneath the selected
folder. 1

* Be careful when deleting folders, because all data in
the folder is deleted.
* Deletions cannot be undone after they finish.

1) The following examples show two situations in which a folder (Work1)
cannot be deleted.

When there is a file that is not managed by XDCAM EX devices

[ Jwork1
([ IBPAV

E File not managed by XDCAM EX devices

When there is another folder (Work2)

Work2

BPAV

Normally, files which are not managed by XDCAM EX devices and
folders such as Work2 must be deleted before the folder Work1 can be
deleted. However, if you use Finder to create a folder or file in Work1
while this application is running, then Work1 may be deleted even while
the folder or file still exists.

Splitting folders

You can split large folders into smaller folders. This allows
you to back up all of the clips in a large folder to media that
is not large enough to save the entire folder without
splitting.

For example, you can split an 8 GB folder into two 4 GB
folders in order to save them on 4 GB DVD-R media. Note
that individual files in the large folder are not split.

You cannot operate clips in other than XDCAM EX format
(for example, XDCAM HD clips). You can operate
XDCAM EX clips only.

1 In the Tree View pane of an Explorer window, select
the folder to split.

2 Do one of the following.

¢ Click the Split Folder button.

 Select [Split Folder...] from the [Edit] menu.

¢ Click the folder while holding down the Control key,
and select [Split Folder...] from the context menu.

The Split Folder dialog opens.

Split Folder

Folder Name :

Sample

Media :
| DVD1 Layer \%i

GB

(_ cCancel ) (st ]

The individual files in split folders are not split. Clips
are assigned to the split folders in such a way that the
split folders have the specified size. This means that it
is not possible to specify a split folder size smaller than
the largest file in the original folder. It is also not
possible to specify a split folder size smaller than 4
GB.

3 Select the type of media from the [Media] list box.

The size of the folder after splitting, as determined by
the selected media type, appears in the edit box
beneath the list box.

If you select “Arbitrary Size”, enter the size (an integer
from 4 to 100) in the edit box.

4 Click the [Start] button.

The folder is split into the minimum number of folders
that will produce the specified folder size, and clips are
assigned to the smaller folders. The folders produced
as a result of the split have the same name as the
original folder, followed by serial numbers.

* Once it starts, a split operation cannot be canceled
before it finishes.

* Split clips may be assigned to different folders. If
you would prefer that split clips be assigned to other
folders, you can move them manually after the
folder split.

Combining folders
You can combine specified folders into another folder.

This allows you to restore the original folder from split
folders.

Folder and Media Operations
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* You cannot operate clips in other than XDCAM EX

format (for example, XDCAM HD clips). You can
operate XDCAM EX clips only.

* To become the target of combination, folders must

1

reside on the same directory level and be under the
management of this application (see page 73).

In the Tree View pane of an Explorer window, select
the destination folder, into which the other folders will
be combined.

Do one of the following.

¢ Select [Combine...] from the [Edit] menu.
* Click the folder while holding down the Control key,
and select [Combine...] from the context menu.

Combine Folders

Combined with:
Sample

Target Folder

| [ Material
=

| Test

"] Delete the folder after combine

[ Cancel ) tart

3 Check the check boxes of the folders that you want to

combine into the folder selected in step 1. Check the
[Delete folders after combine] check box if you want
to delete the combined folders after the combine.

The combined folders are not deleted when:

* They contain other folders.

* You do not have delete/write privileges to the
original folders.

* The folders are write protected.

Click the [Start] button.

The folders selected in step 3 are combined into the
destination folder specified in step 1. The clips in all of
the folders are gathered into the destination folder. If
any of the clips are split clips, they are automatically

grouped, allowing them to be handled as a single clip.

Reasons why a folder combine operation may fail
Folder combine operations may fail for the following
reasons. In these cases, an error message appears and
the combine is not executed.

Folder and Media Operations

* There is not enough free capacity in the combine
destination folder.

* You do not have write privileges to the source or
destination folders.

* The source or destination folders are write protected.

* Multiple instances of the same clip exist.

Checking/editing disc metadata

You can check and edit the disc metadata
(DISCMETA.XML) (see page 73) saved on XDCAM
drives or in folders with MXF attributes.

1 In the Tree View pane of an Explorer window, select
an XDCAM drive or a folder with MXF attributes.

2 Do one of the following.

¢ Select [Edit Disc Metadata...] from the [Edit] menu.

* Right click the XDCAM drive or folder with MXF
attributes and select [Edit Disc Metadata...| from
the context menu.

The Edit Disc Metadata dialog opens.

Edit Disc Metadata

Disc ID: B8D60B00073905C1FBCI080046020120

User Disc ID: | XDCAM HD Demo Disc (59.941)

Title 1 | XDCAM HD Demo Disc (59.94i)

Title 2:

Description: | Demonstration use only

Cancel oK

3 Edit the following items as required.

User Disc ID (up to 127 bytes)
Title 1 (up to 63 bytes)

* Title 2 (up to 127 bytes)

* Description (up to 2047 bytes)

4 Click the [OK] button.
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How XDCAM EX clip data are
configured

Recording format

This application supports the format specified for

XDCAM EX devices. This format has the following

specifications.

* Folder names and the folder configuration are as shown
in the following figure.

* Files contain link information pertaining to links
between files and folders.

* Do not use tools that do not support the XDCAM EX
format to edit, delete, move, or rename the files and
folders used by this application. Unless the format
specifications are observed, files can become unreadable
by XDCAM EX devices and by this application.

* It may not be possible for XDCAM EX devices to play
clips that this application has created on, copied to, or
moved to media other than SxS PRO memory cards.

Recording folders

The configuration of video and metadata folders is as
shown in the following figure.

In the XDCAM EX format, the data beneath the BPAV
folder is handled as a single set of data.

Media or work folder

—{ ]BPav
MEDIAPRO.XML

CUEUPXML
—{ JoLpPr

—(
—(
ABC0000.MP4
" J1AkR
—(

* One BPAYV folder exists when a work folder is opened in
Finder.

* To copy and backup your data, select the folders beneath
the BPAYV folder.

* When a work folder is selected in a Tree View pane of
Explorer window, a list of clips registered in the BPAV
folder appears in the corresponding List View pane. AV
data is saved in the folders beneath the CLPR folder.

* On the media used by XDCAM EX devices, the BPAV
folder is created beneath the root folder of the media.

* When a work folder is selected in a Tree View pane of
Explorer window and the CLPR folder in the work folder
has some MP4 files, new folders are created beneath the
CLPR folder, and the MP4 files are moved to those
folders (the effect is the same as importing the MP4
files).!)

* When MP4 files are imported to a work folder, new
folders are created beneath the CLPR folder, and the
imported clips are moved to those folders. Folder names
are assigned automatically.

* On SxS memory cards and the PHU-60 Professional
Hard Disk Unit, up to 600 clips can be registered in one

recording folder.
1) This process does not work in the UserData folders on XDCAM drives.

Folder and file names are linked to metadata files. Do not
change them.

How MXF clip data are configured

Recording format

This application supports the format specified for

XDCAM HD devices. This format has the following

specifications.

* Folder names and the folder configuration are as shown
in the following figure.

* Files contain link information pertaining to links
between files and folders.

* Do not use tools that do not support the XDCAM HD
format to edit, delete, move, or rename the files and
folders used by this application. Unless the format
specifications are observed, files can become unreadable
by XDCAM HD devices and by this application.

¢ It may not be possible for XDCAM HD devices to play
clips that this application has created on, copied to, or
moved to media other than Professional Discs (XDCAM
drives).

Recording folders

The configuration of video and metadata folders is as
shown in the following figure.
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Media or work folder

DISCMETA. XML
MEDIAPRO.XML
[ Tcip
=) ABC0000.MXF
=] ABCO00OMO1. XML
—{ ] Edit
—{ Jsub
—{ ] General
—{ ] userData

» This application recognizes a folder containing the three
subfolders -- Clip, Edit, and Sub -- as a folder with MXF
attributes, and browses the Clip folder.

* If XDCAM Drive in the General tab of the Preferences
dialog is set to “UserData,” this application browses the

UserData folder instead of the Clip folder (see page 74).

« If file format conversion is executed by copying files to
a normal folder (see page 60), DISCMETA.XML and
MEDIAPRO.XML files, and Clip, Edit, Sub, and
General folders are automatically created, and then the
format-converted files are copied to the Clip folder. (For
example, when the file named ABC0000.MP4 is copied
to a work folder, the format is converted to MXF and the
files named ABC0000.MXF and ABCO000MO1.XML
are automatically created and saved in the Clip folder.)

* Folder and file names are linked to metadata files. Do not
change them.

* Even if you configure clip data like MXF clip data in an
EX folder using Finder or other file management tools,
this application gives priority to the XDCAM EX format
so that you cannot operate MXF clips.

For details about the data configuration for MXF clips,
refer to the Operating Instructions or Operation Manual
supplied with the XDCAM HD device.

User settings

The Preferences dialog allows you to select application
options and processing modes.

To open the Preferences dialog, select [Preferences...]
from the [XDCAM EX Clip Browser] menu.

Appendix

General tab

Preferences

Ceneral Display Play ~ Canversion

Prigrity in Move
® Processing speed
O Data Protection
Copy
™1 Convert in MXF for copying EX to a normal folder
[T Perform CRC check after copy
Copy all files to:

| fUsers/Bl]/Sony [ClipBrowser ri
Clip
Clip ID:  XDZ1
XDCAM Drive
@ Clip
() UserData
Cancel ) ( Ok )

Priority in Move: Specifies whether to give priority to
operating speed or data protection when moving clips
(see page 61).

* Processing speed: Normal move processing, without
creating a duplicate of the clip

* Data protection: Creation of a duplicate before
deletion of the original clip

Convert in MXF for copying EX to a normal folder:

When EX format files are copied to a normal folder
(without EX or MXF attributes) with this check box
checked, the copies are automatically converted to the
MXEF format.

Perform CRC check after copy: When this check box is
checked, the application performs a CRC (cyclic
redundancy check) error check after copying a file,
and displays a message if a copy error is detected.

Copy all files to: Specifies the destination folder for the
Copy All command that copies all clips in a folder or
on a media disc or memory card (see page 60). Enter a
path beginning with a drive name in the edit box. Or
click the [...] button to open a browse dialog, select a
folder, and click the [OK] button.

Clip ID: Specifies up to four characters added to the start
of imported clip names, and to the name of the folder
where the imported clips are saved (see page 63).

XDCAM Drive: Specifies the folder on an XDCAM drive
that this application will use.
¢ Clip: Uses the Clip folder. In this mode, only MXF

clips on the XDCAM drive can be operated
(XDCAM EX clips cannot be operated).

An “XDCAM Drive (normal)” icon is displayed in
the Tree View pane (see page 53).

» UserData: Uses the UserData folder. In this mode,
only XDCAM EX clips on the XDCAM drive can be
operated (MXF clips cannot be operated). This mode
is for backup of XDCAM EX clips.



An “XDCAM drive (UserData)” icon is displayed
in the Tree View pane (see page 53).

For details about the data management structure for the
XDCAM drive available in this application, see page 73.

Display tab
Preferences
General © Display * Play ~ Conversion
Clip Name
XDCAM EX: | By Title '3'}
XDCAM HD: | By Filename &

50p/60p timecode Display Mode
() Show all frames (Ex.00:00:00:35)
) Show * (Ex.00:00:00:17%)

When no more clips can be previewd

) Show a warning.
() Replace the clip that was viewed first.

Cancel ) ( Ok )

Clip Name: Specifies what to display as the clip name for
each clip type.
» By Title: Displays the title as the clip name.
* By Filename: Displays the file name as the clip
name.

Even if “By Title” is selected, the file name is
displayed for a clip with no title assigned.

S50p/60p Timecode Display Mode: Specifies the
timecode display format when the frame frequency of
the playback clip is 50p or 60p.

* Show all frames: The frame number increases on
each frame. (Example of frame number display for
60p clips: 00— 01 =+ 02 — ... & 58 — 59— 00
—...)

* Show *: The frame number increases on every
second frame. An asterisk (*) is added to indicate the
second frame in each frame number pair. (This is the
display format used by Sony VTRs.) (Example of
frame number display for 60p clips: 00 — 00* —
0l > ..—29 —>29%* > 00— ..)

When no more clips can be previewed: Specifies what to
do when the number of clips in Preview windows
(simultaneously open windows or tabs) exceeds the
number that can be previewed at one time.

* Show a warning.

Play tab

Preferences

General Display Play * Canversion

Resolution

| Auto J44
MXF Play mode

() MPEG HD

@ Proxy

Cancel ) ( Ok )

Resolution: Specifies the preview playback resolution.

* Auto: Decodes the playback video at a resolution
which is automatically adjusted to match the screen
size.

* Normal: Decodes the playback video at the original
resolution of the clip, regardless of the screen size.

e 1/2, 1/4: Decodes the playback video at half or
quarter resolution. The image quality is lower, but
response is better because of the lower demands
placed on the decoder.

» Replace the clip that was viewed first.

MXF Play mode: Specifies the playback mode of MXF
clips from among the following.

* MPEG HD: Plays the clips at high resolution (plays
MXF clips as is).

* Proxy: Plays the clips at low resolution (plays the
proxy AV data).

For notes on the playback mode of MXF clips, see page 66.

Conversion tab

Preferences

General * Display  Play ' Conversion

Country

@ NTSClnclude 24p) () PAL
MP4 to MXF canversion by topy

Bit Rate:
4:2:0 | 18Mbps v 4:2:2 | 50Mbps I3
Format Settings: when there's no clip in the folder
(Note: This is not enabled if copying to an XDCAM device which has the system frequency)
Frame Rate: | 60i/60p/30p |4 Format: | 4:2:0 18Mbps{x1080) \3}
Avid AAF

Output OPAtom files to:
fUsers )

Cancel oK
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Country: Specifies the video system adopted in the region
where the application is used.

* NTSC (Include 24p)

* PAL

MP4 to MXF conversion by copy: Specifies the
recording format to be used at the time of file format
conversion from MP4 to MXF by copy operation.

* Bit Rate
Specifies the bit rate of the converted file for each
color format when file format conversion is
performed by copy operation.

- 4:2:0: Selects 18Mbps, 25Mbps, or 35Mpbs.
- 4:2:2: Fixed to 5S0Mbps.

» Format Settings: when there’s no clip in the folder
Specifies the recording format (frame rate and
format) to be used when no clip exists at the copy
destination during file format conversion by copy
operation. The following combinations of the values
can be set.

Country Frame Format
Rate

NTSC (Include |60i/60p/ 4:2:0 18Mbps (x1080)

24p) 30p 4:2:0 25Mbps (x720)

4:2:0 25Mbps (x1080)

4:2:0 35Mbps (x720)

4:2:0 35Mbps (x1080)

4:2:2 50Mbps

24p 4:2:0 18Mbps (x1080

4:2:0 25Mbps (x1080

4:2:0 35Mbps (x1080

)
)
)
)

PAL 50i/50p/ | 4:2:0 18Mbps (x1080

25p 4:2:0 25Mbps (x720)

4:2:0 25Mbps (x1080)

4:2:0 35Mbps (x720)

4:2:0 35Mbps (x1080)

4:2:2 50Mbps

For details about the file format conversion by copy
operation, see page 60.

Output OPAtom files to: Specifies the output folder for
OPAtom files for the [Avid AAF] subcommand of the
Export command (see next item “To set the media
folder in Avid editing systems”). Enter a path
beginning with a drive name in the edit box. Or click
the [...] button to open a browse dialog where you can
select a folder, and then click the [OK] button.

To set the media folder in Avid editing systems
For Avid Media Composer (V2.5.3 or later), proceed as
follows.

1 Select [Media Creation] from the [Settings] menu.

Appendix

The Media Creation dialog opens.

Specify Macintosh HD as the Video Drive/Audio
Drive (media storage drive) in the Import tab.

Import an MXF file into Avid Media Composer.

An “Avid Media FilessMXF/1” folder is created in the
drive specified in step 2.

Specify this folder in the [Output OPAtom files to]
box.



Menu list

This section lists the menus of this application.

In the Keyboard shortcut field, the notation “Command +
N” means that the N key is pressed while holding down the
Command key.

Menu Command Subcommand | Keyboard shortcut Function Reference
page
XDCAM About XDCAM |- - Displays the version of this -
EX Clip EX Clip Browser application.
Browser About - - Displays the version of the -
MainConcept MainConcept plug-in software.
Conversion
Packs
Preferences... - Command +, Opens the Preferences dialog. Page 74
Services Mac OS - Execute various commands provided |—
Commands by the Mac OS.
Hide XDCAMEX |- Command + H Hides this application. -
Clip Browser
Hide Others - Option + Command + H | Hides other applications. -
Show All - - Shows all applications. -
Quit XDCAM EX |- Command + Q Quits this application. Page 50
Clip Browser
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Menu Command Subcommand | Keyboard shortcut Function Reference
page
File New Explorer - - Opens a new Explorer window. Page 51
Window
New Preview - - Opens a new Preview window.
Window
New Tab - Command + T Adds a new tab in the active window. |—
Folder New Folder Shift + Command + N | Creates a new folder in the currently | Page 69
——— selected media or folder.
— Rename Option + Command + R | Renames the selected folder. Page 70
d Close Window |- Command + W Closes the active window. -
§ Close Tab - - Closes the active tab. -
2 Show in Finder... |- Command + N Opens the selected folder in Finder, | Page 70
so that you can back up the folder
contents.
Import... - - Imports an MP4 file to the selected | Page 63
folder.
Export MXF for NLEs... |— Converts the selected clip to MXF Page 64
format, for use on non-linear editors.
MXF for - Converts the selected clip to XDCAM
XDCAM HD... HD format.
MXF for - Converts the selected clip to XDCAM
XDCAM HD422 format.
HD422...
XDCAM Converts the selected clip to XDCAM
MPEG... MPEG IMX format.
XDCAM Converts the selected clip to XDCAM
DVCAM... DVCAM format.
Raw DV... - Converts the selected clip to RAW
DV format.
AVI DV... - Converts the selected clip to AVI DV
format.
Avid AAF... - Converts the selected clip to Avid
AAF format.
Windows Media |- Converts the selected clip to
File... Windows Media file format.
Sony PSP - Converts the selected clip to a format
(H.264/AVC)... for viewing on the PlayStation
Portable (PSP) game console.
Apple iPod - Converts the selected clip to a format
(H.264/AVC)... for viewing on the Apple iPod.
Video Hosting |- Converts the selected clip to a format
Service... for uploading to video hosting
service.
Capture Siill - - Creates a bitmap still picture from the | Page 67
Image... frame at the current position.
New clipusing |- - Creates a new clip from the section | Page 62
In/Out section between In and Out points of the
selected clip.
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Menu Command Subcommand | Keyboard shortcut Function Reference
page
Edit Cut - Command + X Cuts the selected clip. Page 61
Copy - Command + C Copies the selected clip. Page 59
Paste - Command + V Pastes a clip that has been cut or Page 59
copied. Page 61
Delete - Command + Delete Deletes the selected clip or folder. Page 62
Page 70 _
Copy All - Option + Command + C | Copies all of the clips in the selected | Page 60 —
media or folder. —
Select All - Command + A Selects all of the clips in the selected |- d
media or folder. S
Split Folder... - Shift + Command + W | Splits the selected folder into folders | Page 71 8
of the specified size. @
Combine - Shift + Command + J Combines the selected folder to Page 71
Folders... another specified folder.
Find Find... Command + F Opens the Find dialog. Page 68
Start - Starts the search.
Stop - Stops the search.
Go to Explorer |- Opens the selected clip in an
Explorer window.
Edit Disc - - Opens the Edit Disc Metadata dialog. | Page 72
Metadata...
Special - - Open the Character Palette so that |-
Characters... you can enter special characters and
symbols.
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Menu Command Subcommand | Keyboard shortcut Function Reference
page
View Show/Hide - Option + Command + T | Shows or hides the tool buttons. Page 53
Toolbar
Show/Hide - - Shows or hides the Tree View pane. | Page 53
Folder Tree
Up - Command + 1 Moves up one level in the folder -
hierarchy.
Thumbnails - - Puts the List View pane into Page 54
thumbnail view mode.
Details - - Puts the List View pane into details
view mode.
Sort By Clip Name - Sorts the clip list on the selected key,
Si in ascending or descending order.
ize -
Duration -
Status -
Creation Date |-
Last Update -
Rec Mode -
Media Spanning |—
Folder Path -
Save sort order |— Saves the current sort order for the |—
current folder.
Customize - - Opens the Customize Columns Page 55
Columns... dialog.
Message Reset to the - Subsequently displays the message |—
Options default box which was set to be hidden by
the setting of the [Do not show this
message in the future.] check box.
Refresh - - Refreshes the information displayed |-
in the active tab of the Explorer
window.
Full Screen - Option + Return Puts the Viewer into Full Screen Page 56

mode.
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Menu Command Subcommand | Keyboard shortcut Function Reference
page
Preview Play - L or Space Plays the selected clip. Page 66
Stop - K or Space Stops clip play.
Play Reverse - J Plays the selected clip in the reverse
direction.
Play In to Out - Shift + Space Plays the range from the In point to
the Out point of the selected clip.
—1 Frame - “«— Steps one frame back.
+1 Frame - — Steps one frame forward.
Jump to Start - Home Jumps to the clip start point (first
frame).
Jump to End - End Jumps to the clip end point (last
frame).
Jump to In Point |- 1 Jumps to the In point.
Jump to Out - ! Jumps to the Out point
Point
Previous - Shift + «— Jumps to the previous essence mark.
Essence Mark
Next Essence - Shift + — Jumps to the next essence mark.
Mark
Edit Set Index P Sets the frame at the current position | Page 67
Picture as the index picture.
Mark In | Sets an In point at the current Page 62
position.
Mark Out (0] Sets an Out point at the current
position.
Clear Mark In Shift + | Clears the In point.
Clear Mark Out | Shift + O Clears the Out point.
Clear Mark In/ | Shift + X Clears the In and Out points.
Out
Add Essence E Sets an essence mark at the current |—
Mark position (up to 126).
Delete Essence | Shift + E Deletes the essence mark at the -
Mark current position.
Edit Essence - Opens the Edit Essence Marks Page 67
Marks... dialog.
Set Audio - - Opens the Set Audio Channels Page 66
Channels... dialog.
Window Previous Tab - Shift + Command + { Selects the previous tab. Page 52

Next Tab - Shift + Command + } Selects the next tab.
Minimize - Command + M Minimizes the active window. -
Zoom - - Maximizes the active window or -

returns it to its original size.

Bring All to Front

Brings all the currently open windows
to the front of the screen.
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Error and warning message list

Messages

What to do

Failed to initialize OLE. Please confirm whether the OLE
library version is correct.

Failed to read libraries for Export.

There may be a problem with the installation of this application. Try
installing it again.

The folder contains some incomplete clips. Please copy all
files in the [BPAV] folder under the selected folder to an
SxS card and execute salvage operation on the recording
equipment.

Incomplete clip exists. Please execute salvage operation
on the recording equipment.

Data on the media is incomplete, probably because the XDCAM
EX device was powered off during recording, or because the media
was ejected prematurely. Return the media to the XDCAM EX
device and salvage it immediately. The data may become
unrecoverable if you continue to operate without salvaging it.

Reason: The clip database is incorrect.

The XDCAM EX format may be corrupt. Try to salvage the material,
for example by importing an MP4 file to another folder.

The clip cannot be displayed in Explorer.

Check the properties of the selected clip. It cannot be imported or
displayed in the list because the format is not compatible with the
XDCAM EX format.

Failed to save sort order.

Try restarting this application, or restarting the computer. If the
problem persists, install the application again.

The clip database is incorrect, so it cannot be copied.

The clip database is incorrect, so it cannot be moved.

Failed to update properties.

The XDCAM EX format may be corrupt. Try to salvage the material,
for example by importing an MP4 file to another folder.

A file exceeding 4 GB needs to be split, so the file cannot
be copied.

A file exceeding 4 GB needs to be split, so the file cannot
be moved.

Files larger than 4 GB cannot be managed on media like the SxS
memory cards used by XDCAM EX devices. Use editing software
or some other tool to split the file into files smaller than 4 GB and
then try again.

Failed to create a clip.

The operation was cancelled for one of the following reasons.

* You do not have delete and write privileges to the selected media
or folder, or these operations are inhibited.

e The data is in an incompatible format, or it is corrupt.

Check the properties of the media or folder.

Reason: Unmatched frame rate.

The selected clip cannot be copied due to difference in frame rate
between that clip and clips existing in the copy destination folder.
Check the frame rate (NTSC/24p/PAL) of the clip you want to copy
and then perform copy by selecting a destination folder in which all
the existing clips are of the same frame rate as the selected clip.

Reason: The video format is different.

The selected clip cannot be copied due to difference in resolution
between that clip and clips existing in the copy destination folder.
Check the resolution of the clip that you want to copy and then
perform copy by selecting a destination folder in which all the
existing clips are of the same resolution as the selected clip.

Reason: Default format hasn’t been set. Please check
Conversion tab in Preferences.

Set the frame rate and bit rate in the [Rates to apply when rec
format is unknown] section of the Conversion tab in the
Preferences dialog.

Reason: Bit Rate hasn’t been set. Please check
Conversion tab in Preferences.

Make settings in the [MP4 to MXF conversion bit rate] section of
the Conversion tab in the Preferences dialog.

Reason: Failed to convert.

Check the recording format of the clip that you want to copy and
that of the clips existing in the copy destination folder. File
conversion may be disabled depending on the recording format of
the original clip and the clips in the copy destination folder.

Reason: The clip is less than 2 seconds, so it cannot be
written.

It cannot be copied because a Clip less than 2 seconds is
included.

XDCAM devices do not support writing of clips shorter than two
seconds.
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Messages

What to do

UserData folder cannot be specified as the destination to
copy MXF files. Please change the Copy All destination in
Preferences.

Change the setting in [Copy all files to:] of the General tab in the
Preferences dialog.

Failed to import the clip.

Check the properties of the clip. You may not have access
privileges to the clip, or the clip may be an MP4 file that is not
compatible with the XDCAM EX format.

UserData folder cannot be specified as the output
destination.

Change the output destination.

UserData folder cannot be specified as the destination to
output OPAtom files. Please change the OPAtom file
output destination in Preferences.

Change the setting in [Output OPAtom files to:] of the Conversion
tab in the Preferences dialog.

The name is already used. Please specify other name.

Specify other name or change the output destination.

Error occurred during the export. Please refer to the
details from the context on each clip.

Open the export dialog to check the report which is displayed when
[Error detail] is selected from the context menu of the clip with the
error.

Reason: An error occurred during conversion.

The conversion failed for one of the following reasons.

* You do not have delete and write privileges to the output folder,
or these operations are inhibited.

* The selected clip is in an unsupported format, or the material
data is corrupt.

Check the properties of the folder and clip.

Reason: Unsupported XDCAM.

The selected XDCAM drive is not supported.

Reason: Unsupported codec.

The codec of the selected clip on the XDCAM drive is not
supported.

Failed to create a folder.

Check the properties of the selected media or folder. You may not
have delete and write privileges to the media or folder, or these
operations may be inhibited.

You cannot use [XXX] as a folder name. Please specify
another name.

Specify a name other than “BPAV”.

It contains a string reserved by the system, so it cannot be
set.

The name contains characters reserved by the operating system.
Enter a name that does not contain these characters.

Reason: The clip file name has already been reserved.

Change the file name or copy destination.

A name beginning with a dot (.) is used by the system only.
Please give other name for User Disc ID.

Specify other name.

Failed to change the folder name.

Failed to delete the folder.

Failed to split the folder.

Check the properties of the selected folder. You may not have
delete and write privileges to the folder, or these operations may be
inhibited.

Failed to combine the folders.

Check the properties of the combine source or destination folder.
You may not have delete and write privileges to these folders, or
these operations may be inhibited.

[XXX] contains a work folder, so it cannot be deleted.

Reason: [XXX] has a sub folder.

The selected media or folder contains one or more folders that are
not under the management of this application. Delete or move
these folders and then try again.

The folder [XXX] cannot be split. Reason: The folder
contains a file exceeding the specified split unit of [XXX
GB]. Clip name:

The folder cannot be split into folders of the specified size because
at least one file larger than that size exists. Specify a split size that
is larger than the size of the largest file.

Failed to save disc metadata.

Check the properties of the selected XDCAM drive and the state of
the write protect tab on the disc. You may not have delete and write
privileges for the selected XDCAM drive, or these operations may

be inhibited.
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How to obtain the plug-in software

The optional MainConcept plug-in software can be
purchased and downloaded from the following website.
http://www.mainconcept.com/plugin4clipbrowser

Licenses

MPEG-4 Visual Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE MPEG-4

VISUAL PATENT PORTFOLIO LICENSE FOR THE

PERSONAL AND NONCOMMERCIAL USE OF A

CONSUMER FOR

(1) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”)

AND/OR

(i1))DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED BY MPEG LA TO PROVIDE
MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE.

ADDITIONAL INFORMATION INCLUDING THAT
RELATING TO PROMOTIONAL, INTERNAL AND
COMMERCIAL USES AND LICENSING MAY BE
OBTAINED FROM MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/sales
of any storage media storing MPEG-4 Visual video
information (ii) distribution/broadcasting of MPEG-4
Visual video information in any manner (such as online
video distribution service, internet broadcasting, TV
broadcasting). Other usage of this product may be required
to obtain license from MPEGLA. Please contact MPEG
LA for any further information. MPEG LA, L.L..C., 250
STEELE STREET, SUITE 300, DENVER, COLORADO
80206, http://www.mpegla.com

MPEG-2 Video Patent Portfolio License

ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY MANNER
THAT COMPLIES WITH THE MPEG-2 STANDARD
FOR ENCODING VIDEO INFORMATION FOR
PACKAGED MEDIA IS EXPRESSLY PROHIBITED
WITHOUT A LICENSE UNDER APPLICABLE
PATENTS IN THE MPEG-2 PATENT PORTFOLIO,
WHICH LICENSE IS AVAILABLE FROM MPEG LA,
L.L.C, 250 STEELE STREET, SUITE 300, DENVER,
COLORADO 80206.
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AVC Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC

PATENT PORTFOLIO LICENSE FOR THE

PERSONAL AND NON-COMMERCIAL USE OF A

CONSUMER TO

(1) ENCODE VIDEO IN COMPLIANCE WITH THE
AVC STANDARD (“AVC VIDEO”)

AND/OR

(i))DECODE AVC VIDEO THAT WAS ENCODED BY
A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR WAS
OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED

FOR ANY OTHER USE. ADDITIONAL

INFORMATION MAY BE OBTAINED FROM MPEG

LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM

VC-1 Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE VC-1

PATENT PORTFOLIO LICENSE FOR THE

PERSONAL AND NON-COMMERCIAL USE OF A

CONSUMER TO

(1) ENCODE VIDEO IN COMPLIANCE WITH THE VC-
1 STANDARD (“VC-1 VIDEO”)

AND/OR

(ii))DECODE VC-1 VIDEO THAT WAS ENCODED BY
A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR WAS
OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE VC-1 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED

FOR ANY OTHER USE. ADDITIONAL

INFORMATION MAY BE OBTAINED FROM MPEG

LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM
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